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THE ENERGY CONSERVATORY, INC.  SOFTWARE PRODUCT LICENSE AGREEMENT 
(appears during software installation) 

 
This legal document is an agreement between the end user (hereinafter “Licensee”) and The Energy Conservatory, Inc. 
(hereinafter "TEC").  This agreement constitutes the complete agreement between the licensee and TEC for this software 
program, which includes computer software and may include associated media, printed materials and electronic 
documentation (hereinafter “Software Product”) . 
 
BY SELECTING THE YES BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, 
YOU UNDERSTAND IT AND YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS, WHICH INCLUDE 
THE SOFTWARE PRODUCT LICENSE, THE EXPRESS LIMITED WARRANTY AND THE LIMITATION OF 
WARRANTY AND LIABILITY (Collectively the "Agreement").  THIS AGREEMENT APPLIES TO YOU AND ANY 
SUBSEQUENT LICENSEE OF THIS SOFTWARE PRODUCT. 
 
IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF THIS AGREEMENT, PRESS THE NO BUTTON BELOW. 
 
1.  THE ENERGY CONSERVATORY, INC. SOFTWARE PRODUCT LICENSE 
 
A.  GRANT OF LICENSE.  TEC grants to licensee a non-exclusive right to use this copy of the Software Product on a single 
computer at a single location.  This Software Product is licensed, not sold, to you by TEC and may be used, in object code 
form only and only in conjunction with testing hardware and software programs authorized by TEC. You agree not to 
translate, reverse engineer, reverse compile, disassemble or make derivative works from this Software Product.  You may 
neither sublicense the Software Product, nor sublicense or assign the license granted under this agreement, without prior 
written authorization from TEC.  TEC reserves all rights not expressly granted to licensee. 
 
B.  OWNERSHIP OF SOFTWARE.   TEC retains title and ownership of the Software Product.  This license is not a sale of 
the original Software Product or any copy thereof. 
 
C.  COPY RESTRICTIONS.   The Software Product and any accompanying documentation are copyrighted.  Unauthorized 
copying of the Software Product, including software that has been modified, merged, or included with other software, or of 
any accompanying documentation is expressly forbidden. 
 
2.   EXPRESS LIMITED WARRANTY  
 
TEC warrants that the Software Product will perform substantially in accordance with the accompanying written materials for 
a period of 90 days from the date of receipt by the licensee. 
 
3. LIMITATION OF WARRANTY AND LIABILITY 
 
The foregoing warranty is in lieu of all other warranties and is subject to the conditions and limitations stated herein.  TEC 
MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS 
SOFTWARE PRODUCT, INCLUDING ITS QUALITY, RESULTS OBTAINED, PERFORMANCE, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
 
THE EXCLUSIVE REMEDY OF THE PURCHASER FOR ANY BREACH OF WARRANTY shall be the return of the 
Software Product to TEC for replacement, or, at the option of TEC, refund of the purchase price.   
 
IN NO EVENT WILL TEC OR ITS DISTRIBUTORS OR AGENTS BE LIABLE FOR INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR THE INABILITY TO USE THE 
SOFTWARE PRODUCT, even if advised of the possibility of such damages.  In particular, TEC is not responsible for any 
costs including, but not limited to, those incurred as a result of lost profits or revenue, loss of the use of the software, loss of 
data, the cost of recovering such software or data, the cost of substitute software, or the claims of third parties.  In any case, 
TEC’s maximum liability for any and all losses, injuries or damages (regardless of whether such claims are based on contract, 
negligence, strict liability or other tort) shall be the purchase price paid for the Software Product. 
 
This limitation of Warranty and Liability may not be amended or modified, nor may any of its terms be waived except by a 
writing signed by an authorized representative of TEC.
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Chapter 1    Introduction to TECTITE Express  
   
 
TECTITE Express (Ver. 4.0) is an automated building airtightness testing program for PC computers.  The 
TECTITE Express program can be used with the Model 3 or Model 4 Minneapolis Blower DoorÔ  or the 
Series A and B Duct BlasterÒ fans to conduct fully automated Blower Door airtightness tests.  During a 
Blower Door test, the program controls the speed of the Blower Door fan, prompts for installation or 
removal of flow rings, records both building pressure and fan airflow, and calculates and stores test results.  
TECTITE Express can also be used to analyze manually collected Blower Door test data. 
 
 
1.1  TECTITE Express Features 
 
·  Computerized control of Minneapolis Blower Door fans using either a DG-700 Digital Pressure Gauge 

or an APT system.  
·  Choice of three pre-set test protocols (EN 13829, ASTM E779-10 or CGSB 149.10-M86) and custom 

test options.  
·  Pressurization and Depressurization tests can be combined in the same building test file. 
·  Calculation and display of airtightness test results, including deviation from standards listings. 
·  Measurement and display of multiple building zone pressures during the Blower Door test (requires 

additional DG-700, or APT system with 3 or more pressure channels). 
·  Automated operation and on-screen instructions reduce operator error, eliminates time spent zeroing 

gauges and adjusting fan speed, and ensures that tests are conducted the same way every time.    
·  Multiple simultaneous pressure measurements of building pressure and fan airflow reduce the 

variability of test results from wind.  
·  Cruise control for maintaining a constant building pressure during diagnostic tests or airsealing 

activities. 
·  Built-in report generator and file storage features. 
·  On-line HELP screens. 
·  Selectable units for both input screens and reports. 
·  Manual mode for analyzing and displaying manually collected test data. 
 
During automated testing, TECTITE Express adjusts the speed of the Blower Door fan while 
simultaneously monitoring the building pressure and fan airflow using 2 differential pressure channels built 
into either the DG-700 gauge or the APT’s Data Acquisition Box (DAB).  One pressure channel is used to 
measure building pressure while the other pressure channel is used to measure Blower Door fan airflow. 
Communications between the DG-700 or DAB and your computer is provided through either a USB or RS-
232 serial communication link. 
 
 
1.2  Auto Versus Manual Operation 
 
The TECTITE Express program can be run using three different operating methods: 
 
·  The program can be used to fully automate a Blower Door airtightness test using the DG-700 gauge or 

an APT DAB (Auto Method). The Auto Method provides automated collection of building pressure 
and fan flow data, and computerized control of the Blower Door fan. 

·  The Semi-Auto Method provides automated collection of the building pressure and fan flow data, but 
the Blower Door fan is controlled manually. 

·  The program can also be used to enter and analyze manually collected Blower Door test data (Manual 
Method). 
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The three different operating methods are selected from the Test Settings screen (using the Method field).   
The Test Settings screen is discussed in more detail later in Chapter 6.  Much of the operation of the 
TECTITE Express program is the same for the Manual, Semi-Auto and Auto Methods. 
 
 
1.3  Help Buttons 
 
Each screen in the TECTITE Express program contains a Help button to provide you with detailed 
information for that screen.  Wherever you see the Help button, clicking on it will open a text window.  We 
recommend that you use all the Help buttons the first time you run the program.   
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Chapter 2    Setting Up the Hardware for Automated Testing  
 
 
Note:  If you will not be conducting Automated or Semi-Automated Blower Door tests, skip to Chapter 3. 
 
2.1  Hardware Set Up Using a DG-700 
 
1. Install the Blower Door system as described in the Blower Door operation manual. 
 

2. Newer DG-700 gauges contain both a USB and a DB-9 Serial Communication Port, either of  which 
can be used to create a 2-way communication link between the gauge and a computer. We typically 
recommend using the USB port, unless you are working in large commercial buildings and using our 
TECLOG2 datalogging software. In order to use the USB communication port on your DG-700 gauge, 
you will need a USB (A-mini B) cable, and you will need to install the necessary USB drivers onto 
your computer. There are 3 ways to install the USB drivers:   

 

 
Option 1 for Installing USB Drivers (recommended): 
 
Insert the installation CD labeled “USB Drivers for DG-500 and DG-700 Digital Pressure Gauges” into 
a CD drive on your computer (this CD is provided with all Blower Door systems containing a DG-700 
gauge equipped with a USB Communication Port). Your computer should automatically run the file 
“autoinstall.bat” from the CD which will install the necessary USB drivers onto your computer. 
Once the USB drivers are installed, plug the “A” (larger) end of the USB communication cable into an 
open USB port on your computer. Plug the “B” (smaller) end of the cable into the USB 
Communication Port on top of the gauge. The computer operating system should find the gauge and 
perform the final driver setup on your computer.  
 
Option 2 for Installing USB Drivers: 
 
Plug the “A” (larger) end of the USB communication cable into an open USB port on your computer. 
Plug the “mini B” (smaller) end of the cable into the USB Communication Port on top of the gauge. 
The computer operating system should find the gauge and open the “New Hardware Wizard”. 
Follow the instructions in the Hardware Wizard (do not use the Windows Update Search option). Insert 
the installation CD labeled “USB Drivers for DG-500 and DG-700 Digital Pressure Gauges” when 
instructed. The computer operating system should perform the final driver setup on your computer. 

USB Cable 
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Option 3 for Installing USB Drivers: 
 
Download the file “tecportinstaller.exe” to your computer from the following web address – 
www.energyconservatory.com/support4.htm    - see User Tip #1.  Run the program file by double  
clicking on it. The program will install the necessary USB drivers onto your computer.  Once the USB 
drivers are installed, plug the “A” (larger) end of the USB communication cable into an open USB port 
on your computer. Plug the “mini B” (smaller) end of the cable into the USB Communication Port on 
top of the gauge.  The computer operating system should find the gauge and perform the final driver 
setup on your computer.  

 
Note:  If you will be using the Serial Communication Port on the DG-700 gauge, simply plug the male 
end of a standard 9-pin serial cable into the serial port on the top of the DG-700, and the female end 
should be plugged into an open serial communication port on your computer.   
 

3. In order for TECTITE Express to control the speed of the Blower Door fan, you will need to connect 
the DG-700 to the Blower Door fan speed controller using the fan control cable. One end of the fan 
control cable should be plugged into the 3.5 mm fan control output jack on the top of the DG-700, and 
the other end of the cable should be plugged into the side of the fan speed controller case.  Note:  If 
your Blower Door speed controller does not have a communication jack on the side of the controller 
case, you will need to purchase a new speed controller. Also, if you will be conducting a Semi-Auto 
test and manually controlling the Blower Door fan, you will not need to install the fan control cable. 

 

 
4. Connect tubing between the DG-700 and the Blower Door system (tubing connections are detailed in 

the Blower Door operation manual). 

To inside of building 
(leave open if gauge is 
in the building) 

 

To outside (green 
tubing) 

To space upstream of fan inlet. 
(If fan inlet and gauge are in the 
same space, leave open) 

To  BD fan 
(red tubing) 

A B 

Communication Jack 
(Blower Door Speed 
Controller)  

Fan 
Control 
Cable 
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Standard Hardware Set Up with DG-700 (Model 3 and Model 4 Controllers)  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fan Control 
Cable 

To Power Source 

USB Cable 
To Computer 

Building Pressure 
Green Tubing 
(A Reference) 

Fan Pressure 
Red Tubing  
(B Input) 

Fan Power 
Cord 

 

Fan Power Cord 

To Power Source 

USB Cable 
To Computer 

Building Pressure 
Green Tubing 
(A Reference) 

Fan Pressure 
Red Tubing  
(B Input) 

Fan Control 
Cable 

Model 3 

Model 4 
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2.2  Hardware Set Up Using an APT System 
 
1. Install the Blower Door system as described in the Blower Door operation manual. 
 

2. Connect the APT Data Acquisition Box (DAB) to your computer using a 9 pin serial cable. The male 
end of the cable should be plugged into the COM port on the end of the DAB, and the female end 
should be plugged into an open serial communication port on your computer.   

 
Communications Ports/Switches on the DAB 

 
Note:  If your computer does not have a serial port, but does have a USB port, you will need to 
purchase an after-market USB to Serial Port adapter  (contact TEC for adapter recommendations). 
 
3. Connect the Blower Door fan speed controller to the DAB using the fan control cable provided. 

The phone plug end of the cable is plugged into the Fan Control Output Jack on the end of the 
DAB while the other end of the cable is plugged into the communication jack on the side of the 
speed controller. Note:  If your Blower Door speed controller does not have a communication jack 
on the side of the controller case, you will need to purchase a new speed controller.  

 

4. Connect tubing between the DAB and the Blower Door system (tubing connections are detailed in 
the Blower Door operation manual).  Note: If you will be measuring building zone pressures 
during the airtightness test using Channels P3 – P8, refer to Chapter 10 for more information on 
installing tubing from the DAB to the zones to be tested. 

 

 
 
 
 
 
 
 
 

To outside 
(green tubing) 

To inside of building 
(leave open if DAB is 
in the building) 

 

To  BD fan 
(red tubing) 

To space upstream of fan inlet. 
(If fan inlet and DAB are in the 
same space, leave open) 
 

INPUT 

REF 

P1 P2 

DC
12V

OFF

ON FAN
COM

Serial  Communication Port 
Fan Control 
Output Jack 
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Standard Hardware Set Up with APT System (Model 3 and Model 4 Controllers) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Fan Control 
Cable 

To Power Source 

Serial Cable 
To Computer 

Building Pressure 
Green Tubing 
(P1 Reference) 

Fan Pressure 
Red Tubing  
(P2 Input) 

Fan Power 
Cord 

Model 3 

Fan Control Cable 

Serial Cable 
To Computer 

Building Pressure 
Green Tubing 
(P1 Reference) 

Fan Pressure 
Red Tubing  
(P2 Input) 

Model 4  

Fan Power Cord 

To Power Source 
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2.3  Optional Computer Stand 
 
The Energy Conservatory sells an optional 
laptop computer stand for conducting 
automated Blower Door tests. To use the 
computer stand, first open the stand tripod to 
the desired height and attach the flat tray.  
Now gently clamp the digital gauge board or 
DAB mounting board to the aluminum 
tripod pole using the adjustable C-clamp on 
the back of the board.  Place your computer 
on the tray and you are now ready to make 
the connections between the computer, the 
DG-700/DAB and the speed controller. 
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Chapter 3    Setting Up the Building for Testing   
 
 
After installing the Blower Door system, you will need to set up the building in its normal heating or 
cooling mode.  This typically includes closing adjustable openings and preparing combustion appliances.  
Refer to your Blower Door manual for more specific instructions (or refer to set-up guidelines 
provided to you from other sources). 
 
 
3.1  Adjustable Openings   
 
·  Close all storm and prime windows. 
·  Close all exterior doors and attic or crawlspace hatches connected to conditioned spaces.   
·  Open all interior doors to rooms that are heated or cooled.  The object here is to treat the entire 

building as one connected space.  Because few basements can be completely sealed from the building 
and usually some conditioning of basement air is desirable, they are typically included as conditioned 
space. 

·  Tape plastic over window air conditioners if they appear to be a source of air leakage into the building 
and they are removed during the heating season. 

 
 
3.2  Combustion Appliances/Exhaust Devices 
 
·  Adjust all combustion appliances so they do not turn on during the test.  This is commonly done by 

temporarily turning off power to the appliance, or setting the appliance to the “pilot” position.  Note:  If 
vented combustion appliances turn on during a depressurization test, it is possible for flames to be 
sucked out of the combustion air inlet (flame rollout).  This is a fire hazard and can possibly result in 
high CO levels. 

·  Be sure that fires in fireplaces and woodstoves are completely out.  Take precautions to prevent ashes 
from being blown into the building during the test.  In most cases closing dampers and doors is 
sufficient, but when they are leaky or absent, it will be necessary to tape fireplace doors shut, clean out 
the ashes, or cover the ashes with newspaper. 

·  Turn off all exhaust fans, vented dryers, air conditioners and air handler fans. 
 
 
 
 



 
Chapter 4    Starting the TECTITE Express Program 

 

TECTITE Express  
Version 4.0 

10 

Chapter 4    Starting the TECTITE Express Program   
 
 
4.1  Turn on the DG-700/DAB and Fan Speed Controller  (Auto Methods Only) 
 
·  Turn on the DG-700 or DAB (plug in the DAB’s power supply if necessary).  If the DAB’s internal 

NiCad battery is fully charged, it should supply power for approximately 6 hours of continuous 
operation. 

·  Turn the Blower Door fan speed controller to the “just on” position (the fan should not be turning in 
this position). The speed control knob should be turned all the way down, without being clicked into 
the “off” position. Note:  The speed controller should have already been plugged into the fan and into a 
power source.  

 
 
4.2  Starting TECTITE Express 
 
To start TECTITE Express, click on Start...All Programs...Energy Conservatory...TECTITE Express 
4.0. 

 
The main TECTITE Express screen will now appear, with the Main Menu containing File, Options, Goto 
and Help located in the upper left hand corner. 
 

 Main TECTITE Express Screen 

TECTITE Express 4.0 
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Chapter 5    Overview  (Auto, Semi-Auto and Manual Methods ) 
 
 
5.1  Starting a New Test 
 
To start using the TECTITE Express program, open the File Menu by clicking on File in the Main Menu.  
The top of the File Menu contains three starting options: 
 
 
 
 
 
 

�  New Test   is selected to begin a new building airtightness test using the factory default 
program settings.  Both the Test Standard Selection and Equipment Information windows are 
automatically opened so that you can select the appropriate test standard, and the correct fan 
model being used for the test.  After selecting the test standard and fan model, the Building 
Test Information screen will appear.  

�  New Test with Custom Configuration   is selected to begin a new building airtightness test 
using custom configuration files which you have previously created and saved.  Using 
configuration files is the most efficient way to run TECTITE Express.  Creating and saving 
configuration files is discussed in Chapter 14.  After selecting a configuration file to load, the 
Building Test Information screen will appear. 

�  Retrieve Existing Test   lets you recall a previously saved building test file.  After selecting 
the building test file to retrieve, the values from the retrieved file are loaded into the program, 
and the Building Test Information screen appears.  Once a file is recalled, it may be viewed, 
edited and re-saved (with the same or a different file name).  Refer to Chapter 11 for more 
information on retrieving and saving files. 

 
Menu choices are selected by clicking on the desired option.  We recommend that first time users begin by 
selecting New Test.  The other starting options should be explored after familiarizing yourself with the 
TECTITE Express program.   
 
 
5.2  Input Screens 
 
The first 2 screens the TECTITE Express program are used to enter information about the customer, the 
building being tested, and any relevant comments that you would like to save along with the test file.  An 
overview of the 2 screens is shown on the next page.  You can click on individual fields to enter 
information, or use the Tab key to quickly move between fields.  To clear a screen, click on the Clear 
button at the bottom of each page.  When you are finished with a screen, click on the Next button to 
proceed.  At any time, you can step back to earlier screens by using the Previous button. 
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Building Test and Comments Screens 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5.3  Auto Test Method 
 
After completing the Comments screen, click on Next to move to the Test Settings screen.  (Note: If you 
want to operate using the Manual data entry method, refer to the Section 5.4 below.) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Building Test Information Screen: 
   The Building Test Information screen is  
   used to input information about the  
   customer for whom the airtightness test is  
   being performed, as well as the address and 
   physical dimensions for the building being 
   tested. 

Test Settings Screen: 
   The Test Settings screen is used to input 
   settings that will be used during the  
   airtightness test.  When conducting automated 
   tests, be sure the Method button is set to  
   Auto (or Semi-Auto if you will be conducting a  
   Semi-Auto test). Click on Next to move to the 
   Test Graph Screen.  Note: If you choose the  
   EN 13829 test standard, a separate EN 13829  
   data entry screen will appear before the Test  
   Graph screen.  
 

Comments Screen: 
   The Comments screen is used to enter an  
    unlimited number of lines of comments on  
    the building being tested.  Comments are  
    stored with the test file and are printed out  
    along with the test report. 
 



 
Chapter 5    Overview  (Auto, Semi-Auto and Manual Methods) 

TECTITE Express  
Version 4.0 

13 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5.4  Manual Test Method 
 
After completing the Comments screen, click on Next to move to the Test Settings screen: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Test Graph (Manual Method): 
   When using Manual Method, manually 
   entered test data are displayed on this screen. 
   To begin entering data, click on the Data 
   Table button.  

Test Graph (Auto Method): 
   The automated airtightness test and cruise 
   control features are controlled from this 
   screen.  During an automated test, Blower  
   Door test data are collected by TECTITE  
   Express at a series of target building  
   pressures, which are designated by the  
   vertical blue lines on the graph.  To begin a 
   test, click on the Start Test button. 

Test Settings Screen: 
   To set the program for manual entry of 
   Blower Door test data (i.e. building and 
   fan pressure readings), be sure the Method 
   button is set to Manual.  Click on Next to 
   move the Test Graph screen.  Note: If you 
   choose the EN 13829 test standard, a separate 
   EN 13829 data entry screen will appear before  
   the Test Graph screen.  
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5.5  Test Results 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Data Table: 
   The data table is used to input Blower Door 
   test data that were collected manually, rather 
   than collected automatically by TECTITE  
   Express.  The data table will allow entry of  
   up to 12 sets of Blower Door test readings, 
   plus pre-test and post-test baseline 
   building pressure readings.  The Data Table   
   baseline pressure entry fields will change  
   depending on which Test Standard (CGSB,  
   ASTM E779-10, or EN 13829) is chosen in the  
   Test Settings screen.  After you have entered  
   all data into the table, click on OK to return to 
    the Test Graph.   

Test Results: 
  To look at the calculated test results, click on      
  Next from the Test Graph screen.  Test results    
  are automatically calculated using all data points  
  displayed on the graph, and values input into   
  the Building Information and Test Settings 
  Screens.  From the Test Results screen, click on  
  Next to see the Deviations from Standard  
  screen.  Note: If you are conducting an  
  Automated (or Semi-Auto) test, and were  
  measuring zone pressures during the Blower  
  Door test, the Next button will first take you to  
  the Zone Data screen, before going the  
  Deviations from Standard screen..   
 
Deviations from Standard: 
  This screen lists aspects of the current test data 
   that deviate from the selected Test Standard. 
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5.6  Zone Data (Auto and Semi Auto Methods Only) 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
5.7  Using the Goto Menu 
 
The Goto item in the Main Menu allows you to quickly move to any active screen within the TECTITE 
Express program.  Clicking on Goto will bring up the following dialog box.  

 
 
 
 
 
 
 
 
 

 
Simply click on one of the active choices to immediately move to that screen.  If no test data have been 
taken (or manually entered), the Test Results, Zone Data and the Deviations from Standard screens will not 
be available. The EN 13839 Data Entry screen is only available if the EN 13829 test standard has been 
selected in the Test Settings screen. 
 
 
 
 
 
 
 

Zone Data: 
  To look at the measured zone data, click on      
  Next from the Test Results screen.   
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Chapter 6    Editing the Input and Test Settings Screens  
 
 
6.1  Building Test Information Screen 
 
The Building Test Information screen is used to input both customer and building specific information.  To 
enter information, click on individual fields, or use the Tab key to quickly move between fields.  To clear 
the screen, click on the Clear button.  When you are finished entering the information, click on Next to 
move to the Comments screen. 
 
The first three fields on this screen are used to enter the date of the test, the name of the technician 
performing the test, and an optional project number.  The Customer Information section contains fields to 
input the name, address and contact information of the customer for whom the airtightness test is being 
conducted.   
 
The Building Information and Building Dimensions sections are used to input the address and physical 
measurements for the building being tested.  If any of the fields in the Building Dimensions section are left 
blank, the test can still be completed, however test results requiring those inputs will not be calculated or 
displayed on the Test Results screen.  
 
All information entered on this screen is stored as part of the test file. 
 

Building Test Information Screen 

 
 
Volume:  Enter the volume of the building’s intentionally heated or cooled spaces.  If you are testing a 
building with a basement, we recommend that you include the basement if it is to be kept closer to inside 
temperature than outside temperature.  (If you include the basement in your volume calculation, perform the 
Blower Door test with any doors between the basement and the building kept open.). 
 
If you enter a value of 0 (or leave the field blank), Air Changes per Hour at 50 Pascals will not be 
calculated or printed. 
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EN 13829 Standard:  According to EN 13829, the internal volume (V) is defined as:  
“Deliberately heated, cooled or mechanically ventilated space within a building or part of a 
building subject to the measurement, generally not including the attic space, basement space and 
attached structures.” 

 
Floor Area:  Enter the floor area of the building.  This value typically includes all floors in intentionally 
heated or cooled spaces.  If you have included the basement in your volume calculation, also include the 
basement in the floor area calculation.   
 
If you enter a value of  0 (or leave the field blank), this variable will not be calculated. 
 

EN 13829 Standard:  According to EN 13829 the floor area, or AF, is defined as:  “ The total floor 
area of all floors belonging to the internal volume subject to the test.  It is calculated according to 
national regulations.”   

 
Surface Area:  Enter the surface area of the exterior envelope of the building.  This value typically 
includes all walls, floors and ceilings bordering the volume being tested.   
 
If you enter a value of  0 (or leave the field blank), this variable will not be calculated. 
 

EN 13829 Standard:  According to EN 13829, the envelope area, or AE, is defined as:  “The total 
area of all floors, walls and ceilings bordering the internal volume subject to the test.  This includes 
walls and floors below external ground level.  Overall internal dimensions shall be used to 
calculate this area.  No subtractions shall be made for the area at junction of internal walls, floors 
and ceilings with exterior walls, floors and ceilings. (see figure 1 of EN 13829, November, 2000).”  
Note:  In the context of this standard, the envelope area of an apartment in a multiple story 
building includes the floors, walls and ceilings to adjacent apartments.   

 
Uncertainty in Measured Dimensions:  This field needs to be completed if you are performing an EN 
13829 test.  Enter the estimated uncertainty in the building dimensions.  Enter 3% if building dimensions 
(Volume, Floor Area and Surface Area) have been measured internally and 12% if the building dimensions 
have been estimated based on exterior building dimensions 
 
 
6.2  Comments Screen 
 
The Comments screen can be used to enter an unlimited number of lines of comments on the building being 
tested.  Comments are saved along with the building test file and are printed out as part of the test report.  
Typical comments entered on this screen include client interview information, building and weather 
conditions during the test, and the location of major air leakage sites.  To begin entering comments, click 
anywhere within the comment box to activate the cursor.  To clear the Comments screen, click on the Clear 
button.  When you are finished entering comments, click on Next to move to the Test Settings screen, or 
Previous to move back to the Building Test Information screen. 
 
Note:  You can access standard Windows copy and paste commands within the Comments screen by  
clicking on the right mouse button.  This allows you to easily move text between TECTITE Express and 
other Windows programs such as Microsoft Word.   
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6.3  Test Settings Screen 
 
The Test Settings screen is used to set up the airtightness test procedures to be used by the TECTITE 
Express program.  To edit the Test Settings screen, click on individual fields, or use the Tab key to quickly 
move between fields.  When you are finished selecting test settings, click on Next to move to the Test 
Graph screen, or Previous  to move back to the Comments screen.  
 
Note:  When using the Manual Method for data entry, only the Standard and Method fields are active. 
 

Test Settings Screen 

 
 
Standard: 
 
Choose from the following three test standards: 
 

�  CGSB (149.10-M86):    The Canadian General Standards Board test standard consists of an  
8 point Blower Door test conducted at target building pressures varying from 50 to 15 Pascals.  
The CGSB standard allows for either a depressurization test, or a pressurization test to be 
performed. 

 

�  EN 13829:    The European test standard consists of a Blower Door test conducted at a 
minimum of 5 target building pressures.  The maximum target building pressure must not be 
less than 50 Pascals, and the interval between target building pressures must not exceed 10 
Pascals.  The EN 13829 standard allows for either a depressurization test, a pressurization 
test, or both to be performed. 

 

�  ASTM E779-10:   The ASTM E779-10 test standard consists of a Blower Door test 
conducted at a minimum of 5 target building pressures.  The target building pressures may 
vary from 60 to 10 Pascals, and the interval between target building pressures must not exceed 
10 Pascals.  The E779 test procedure requires both a depressurization and a pressurization test 
to be performed. 

 
 The choice of test standard will affect the data entry requirements and the test results. 
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Method:    
 
Click on Manual if you will be manually entering the Blower Door airtightness test readings (i.e. building 
and fan pressure readings).  Select Auto if a fully automated test will be performed including computerized 
control of the Blower Door fan.  Select Semi-Auto if the test data will be collected automatically, but the 
Blower Door fan will be controlled manually. 
 
Test Pressures (only available when Auto and Semi-Auto Methods are selected):    
 

�  Default:    the test will be performed at the target building pressure values specified in the 
selected test standard.  For most users, this is the preferred test method. 

 
�  Custom:    allows the user to create a custom list of up to 12 target building target pressures at 

which Blower Door data will be collected.  Once Custom has been selected, click on the Edit 
Custom Pressures button to open the list of custom target building pressures.  Click on the 
Help button on the custom pressure list window for more information. 

 
Zonal Pressures (only available when Auto or Semi-Auto Methods are selected): 
 
If you are using multiple DG-700 gauges (1 primary and up to 3 auxiliary gauges), or an APT System with 
3 or more pressure channels, you can activate the Zonal Pressures feature (by clicking on the Active button) 
to allow the simultaneous measurement of building zone pressures during the Blower Door test.  Once 
activated, the Settings button can be used to access the Zonal Pressures Set-Up screen.  Click on the Help 
button in the Zonal Pressures Set-Up screen, or refer to Chapter 10 for more information on using this 
feature. 
 

 
Auto Test Parameters (only available when Auto or Semi-Auto Methods are selected):  
 

�  Samples Per Station:   The Samples Per Station field is the number of readings (or samples) 
of building pressure and fan flow that are taken at each pressure station (i.e. target building 
pressure) during an automated test.  Each reading or sample is displayed on the graph as a 
small dot as it is collected.  The default number of samples is 100, and should work fine for 
most test applications (you may vary this number from 1 to 1000).  In most cases, larger 
numbers of samples will lead to higher correlation coefficients.  If the Zonal Pressures 
feature is active, the Samples Per Station also determines the number of zone pressure 
measurements taken for each active zone pressure channel.  

 
If the CGSB test standard is selected, the number of samples per station is also used to 
determine the number of pre and post test baseline building pressure readings that are taken 
during an automated test sequence.  If the EN 13829 test standard is selected, the number of 
baseline samples will be automatically extended to span a time interval of at least 30 seconds.  
If the E779 test standard is selected, the number of baseline samples will be automatically 
extended to span a time interval of at least 10 seconds. 
 

�  Fan Adjust Rate (not available when Semi-Auto is selected):   During either an automated 
airtightness test or a cruise procedure, the computer is in charge of adjusting the fan speed to 
reach the desired (or target) building pressures.  The Fan Adjust Rate determines how 
quickly the fan speed changes as the computer tries to achieve the target building pressure.  
For most cases, the factory default Fan Adjust Rate of 1.0 will work fine. In some cases, such 
as windy weather, it may be necessary to reduce the fan adjust rate to prevent the fan from 
responding too quickly to pressure changes caused by the wind.  In such cases, try a lower 
setting (e.g. 0.2 or 0.1) so that  the fan adjusts slowly enough to successfully complete the test.  
If you would like to speed up fan response, try a higher setting (e.g. 2.0 or 3.0). 
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Note:  When changing the Fan adjust rate, do not enter values greater than 5 or less than 0.1.  
In addition, the fan speed can be manually adjusted by dragging the manual fan speed 
adjustment slider on the Test Graph, or by pressing down on the Up and Down arrow keys 
(the arrow keys are only active when the manual adjustment slider is highlighted). 
 

�  Target Tolerance (not available when Semi-Auto is selected):   The Target Tolerance is 
used by TECTITE Express to determine whether the measured building pressure is close 
enough to the target building pressure so that data collection may begin.  The Target 
Tolerance is a number (in Pascals) stating how close the actual building pressure needs to be 
to the target pressure before a reading will be taken.  In most cases the factory default setting 
of 2 (Pa) works fine. In windy weather you may need to increase the target tolerance (e.g. 3 or 
4) to account for the fluctuations in building pressure caused by the wind.  The target 
tolerance used has little impact on the final test results, but your particular test standard (e.g. 
CGSB) may require you to get very close to your target pressures. 

 
Note:  If during an automated test you would like to manually instruct the computer to go 
ahead and take data, click on the Sample button.  At this point the computer will proceed with 
data collection just as if it had decided that the target tolerance had been met. 

 
�  Building High Pressure Limit:    If TECTITE Express detects a building pressure higher than 

the set Building High Pressure Limit, the fan will shut off immediately and you will be 
informed that the maximum allowable building pressure was exceeded.  The purpose of the 
Building High Pressure Limit is to prevent damage to the building from excessive test 
pressures.  The default setting is 90 Pa.  If the maximum allowable building pressure is 
exceeded during a Semi-Auto test, you will see a warning message and should immediately 
shut down the fan.  Note: The Blower Door fan calibration parameters are not accurate above 
test pressures of 80 Pa. 

 
�  Fan Start % (not available when Semi-Auto is selected):   Enter a number, typically in the 

range 1% to 25%.  At the beginning of an automated test or cruise procedure, the fan output 
signal from the DG-700/DAB will immediately be set to this value to reduce the delay 
associated with fan startup.  A good value for this parameter can be determined by manually 
moving the fan control slider and estimating at which point the fan begins to turn.  This allows 
you to customize the computer control to the particular combination of fan motor and 
controller being used.  This value is stored in the building test files (.bld) and configuration 
files (.cfa).  The default value is 0. 

 
The Fan Start % setting will not affect the minimum fan output which may occur during 
cruising or automated testing.  The computer will still be allowed to reduce the fan output 
below the Fan Start % value if needed to achieve low target pressures. 
 
Note:  If you input an inappropriately high Fan Start %, the fan will begin operation at a 
high speed and may trigger the warning message (Exceeded Maximum Building Pressure).  
Reduce the Fan Start % setting if this occurs. 

 
�  Restore Factory Settings:   The Restore Factory Settings button will restore the factory 

default settings for all five Auto Test Parameter fields. 
 

 
Set as Defaults for New Tests: 
 
Clicking on this box will save the currently selected Standard, Method and Auto-Test Parameters so that 
they will be used for all future new tests.  
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6.4  EN 13829 Data Entry Screen 
 
If you selected the EN 13829 test standard, you will need to complete the EN 13829 Data Entry screen 
before proceeding to the Test Graph screen. 
 

EN 13829 Data Entry Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Type of Test Method: 
 
Choose one of the two test methods (Method A or Method B) described in Standard EN 13829.  The two 
test methods are used for different test purposes and require different building preparations. 
 

�  Method A   (test of a building in use) 
 

�  Method B   (test of the building envelope) 
 
Consult your local program guidelines for more information on preparing the building for an EN 13829 test.  
If neither choice is applicable, leave this field blank. 
 

 
Wind Class: 
 
The Wind Class is a qualitative description of the wind conditions during the test.  The scale used is the 
Beaufort Scale, as detailed in Annex D of the EN Standard, Table D.1. 
 

�  Calm:  less than 0.45 m/s, smoke rises vertically. 
 

�  Light Air:   .45 to 1.34 m/s; direction of wind shown by smoke but not by wind vanes. 
 

�  Light Breeze:  1.8 to 3.1 m/s, wind felt on face; leaves rustle; ordinary vane moved by  wind. 
 

�  Gentle Breeze:  3.6 to 5.4 m/s, leaves and small twigs in constant motion; wind extends light 
flag. 

 
�  Moderate Breeze:  5.8 to 8 m/s, raises dust and loose paper; small branches are moved. 
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�  Fresh Breeze:  8.5 to 10.7 m/s, small trees in leaf begin to sway; crested wavelets form on 

inland waters. 
 

�  Strong Breeze:  11.2 to 13.9 m/s, large branches in motion; telegraph wires whistle; 
umbrellas used with difficulty. 

 
�  Moderate Gale:  14.3 to 17 m/s, whole trees in motion; inconvenience in walking against 

wind. 
 

�  Fresh Gale:  17.4 to 20.6 m/s, breaks twigs off trees; generally impedes progress. 
 

 
Building Wind Exposure: 
 
Select a description of the building’s wind exposure: Highly Protected, Partly Exposed or Highly  
Exposed. 
 

 
Type of Heating, Air Conditioning, and Ventilation: 
 
Standard EN 13829 requires that the type of heating, air conditioning and ventilation be reported.  Enter a 
brief description of each system or "none" as appropriate.  
 

 
Requirement:   
 

�  Regulation Complied With:  Enter the regulation description, otherwise leave this field 
blank. 

 
�  Limiting Value:  From the drop down list, select the limiting value metric for the test being 

performed, otherwise leave this field blank.  If you enter a limiting value metric, also enter the 
actual test limit that is specified in the test regulation. 
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Chapter 7    Conducting an Automated Airtightness Test  
 
 
7.1  Overview of Test Graph Screen (Auto Method) 
 
The automated airtightness test is conducted from the Test Graph screen.  The main feature of the Test 
Graph screen is a plot of Blower Door fan airflow (or building leakage) on the vertical axis versus building 
pressure on the horizontal axis.  During a Blower Door test, data are automatically collected at a series of 
pre-set target building pressures, which are designated by the vertical (blue) lines on the graph.  The target 
building pressures are determined in the Test Pressures section of the Test Settings screen.   
 

Test Graph Screen (Auto Method) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*   Building pressure values shown on the graph and in the Bldg Pressure status window are adjusted for the     
     measured baseline pressure. 
** Zonal pressure values shown in the Zone Pressure status windows are adjusted for measured zonal   
     baseline pressure. 
 
During a fully automated test sequence, the Blower Door fan will turn on and increase speed until the 
building pressure reaches the highest target pressure line shown on the graph (e.g. 50 Pa for a CGSB test).  
Once the appropriate building pressure is achieved, TECTITE Express takes a number of simultaneous 
measurements of building pressure and fan airflow (the default number of samples is 100).  Each sample is 
displayed on the graph as a small dot as it is collected.  When the system is finished collecting samples for 
the first target pressure line, the average value of all samples for that target pressure is displayed as a red 
circle.  The fan speed is then reduced until the building pressure reaches the next target pressure line and the 
data collection process is repeated. The number of data samples taken at each target building pressure is 
determined by the Samples per Station field in the Test Settings Screen.  Once data has been collected at 
each target pressure, a best fit regression line is drawn through the data points. 

Current Zone Pressures (only if Zones active) ** 

Selected Fan Model, 
Test Mode and 
Flow Ring 

Manual Fan  
Speed Control 

Real-Time ACH50 
Estimator (only for 
Cruise and Monitoring) 

Current Fan Flow 
And Fan Pressure 

Current Building 
Pressure * 

Baseline Building 
Pressure 

Completed Test 
Indicator 

Sample Counter 
 

Flow Through the 
Blower Door Fan 
(Building Leakage) 

Pressure Difference Between Inside 
And Outside (Building Pressure) * 
 

DAB Status Box 
 

Blower Door Data 
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Note:  If you are conducting a Semi-Automated test sequence, you will need to manually adjust the 
Blower Door fan to achieve the appropriate building pressure, and then press the SAMPLE button 
to initiate the automated measurement of building pressure and fan flow.   

 
If the Zonal Pressures feature has been activated from the Test Settings screen, the Zone Pressure status 
window will display the current measured zone pressures during the course of the automated test.  While 
TECTITE Express is collecting data for the building airtightness test (from Channels P1 and P2), it will 
also collect data from each active zone pressure channel (P3 – P8).  The number of data samples taken for 
each active zone pressure channel is determined by the Samples per Station field in the Test Settings 
screen. 
 
In addition to the graphical display, the TECTITE Express program will provide a series of messages or 
prompts on the Test Graph Screen to ensure that proper testing procedures are followed.  The program also 
detects common testing or equipment problems (e.g.  tubing connected to the wrong  pressure tap) and 
provides a warning message to the operator. 
 
 
7.2  Selecting the Fan Model 
 
Before beginning a test, be sure that the selected fan model displayed at the top right side of the Test Graph 
screen matches the Blower Door fan being used.  To change the selected fan model, click on 
Options…Equipment Info from the Main TECTITE Express Menu.   
 

Equipment Information Window 

 
In the Equipment Information window, select the appropriate fan model, and then click on OK.  You may 
also input a fan serial number which will be stored along with the building test file, and is printed out on the 
test report.  Importantly, if you change the selected fan model while test data are displayed on the graph, the 
test data will be automatically cleared.   
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7.3   Establishing a Communication Link(s) 
 
Establishing Communication Between TECTITE Express and the DG-700 or APT DAB: 
 
Before beginning an automated test or cruise procedure, TECTITE Express checks to be sure that your 
computer is communicating properly with the DG-700 gauge(s) or APT DAB(s) that are connected to the 
designated COM Ports in the COM Port Selection window (available from the main Options menu).  
Automated testing, Semi-Automated testing or cruising cannot begin until the necessary communication 
link(s) have been established.  Once the proper communication links have been established, the message 
Idle - Monitoring  appears in a green DAB Status window at the bottom of the Test Graph screen and the 
Start Test button is activated. 
 

�  Primary COM Port:  The Primary Device is the DG-700 or APT DAB that will be used to 
measure building pressure and fan flow during the Blower Door test.  The Primary COM 
Port is the communication port on your computer that will be used to communicate with the 
Primary Device. 

 
Checking the AUTO SELECT button in the COM Port Selection window will allow 
TECTITE Express to automatically search for TEC devices on all available communication 
port on your computer.  If you are unsure which COM Port to use, check the AUTO SELECT 
button.  AUTO SELECT will attempt to establish a communication link with the first Energy 
Conservatory Device that it finds. If a communication link is established, this device is 
considered the Primary Device. 
 
If you uncheck AUTO SELECT, you may specify a Primary COM Port  (COM 1 through 
COM 256).   

 
COM Port Selection Window 
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�  Aux:  Aux Device(s) are additional DG-700s or APT DABs that can be used exclusively to 

measure zonal pressures during the Blower Door test.  The Aux COM Port(s) are the 
communication ports on your computer that will be used to communicate with the Aux 
Device(s).  Aux Devices can only be used with the Zonal Pressures feature of TECTITE 
Express.  

 
Note:  If the Primary Device is an APT DAB with 3 or more pressure channels, you can use 
installed pressure channels 3 through 8 on the APT DAB along with the Zonal Pressure 
feature, without specifying an Aux COM Port . 

 
�  Scanning for Port and Devices:  The easiest way to quickly check your computer for all 

currently installed communication ports and connected Energy Conservatory Devices is to use 
the Scan for Ports and Devices button in the COM Port Selection window.  Once the Scan 
window is open, clicking on Start Scan will provide a list of all installed communication 
ports on your computer.  The scan will also show all Energy Conservatory Devices that are 
connected to the listed communication ports.   

 
Note:  The Energy Conservatory Device must be ON to be detected. 

 
For more information on establishing communication between the your computer and the DG-700/DAB, see 
Chapter 15. 
 
 
7.4 Starting an Automated Test 
 
Select the Test Mode:   
 
The currently selected Test Mode is displayed in the upper right-hand corner of the Graph screen.  Use the 
selection arrow to choose the appropriate Test Mode for the test you are about to perform.  Choose 
Depressurization if the Blower Door will be blowing air out of the building (i.e. the building will be at a 
lower pressure than outside).  Choose Pressurization if the Blower Door will be blowing air into the 
building (i.e. the building will be at a higher pressure than outside).  Be sure the Blower Door system has 
been installed properly for the selected Test Mode. 
 
Start Test Button: 
 
Clicking on the Start Test button will begin an automated airtightness test sequence.  The TECTITE 
Express program will guide you through the test sequence using a series of operator messages.  
 
A fully automated test sequence includes the following steps: 
 
1. The operator is prompted to enter specific environmental data (temperatures, barometric pressure, etc.) 

for the test being performed. 
2. The operated is prompted to cover the fan inlet so that the TECTITE Express can measure the baseline 

building pressure (due to wind and stack effects) prior to the test.  Install the flow ring set including the 
no-flow plate or install a nylon fan cap to cover the fan inlet opening, then click on OK. 

3. TECTITE Express will automatically begin to measure the pre-test baseline building pressure.  The 
number of building baseline readings made will depend on the selected Test Standard and Samples 
per Station fields in the Test Setting Screen.  Once the pre-test baseline measurement is completed, the 
average value of  the baseline readings is displayed in the Bldg Baseline (Pa) status window on the 
right side of the screen.  All subsequent building pressure measurements shown on the graph and in the 
Building Pressure status window will be adjusted by this measured baseline pressure.  TECTITE 
Express will also measure the baseline pressure for any active zone pressure channel at the same time. 
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Note: If you are doing an EN 13829 test, you will also be notified of the average value of the positive 
(+) and negative (-) building baseline readings. 

4. The operator is prompted to remove the fan inlet cover and install the appropriate flow ring on the fan 
for the beginning of the test.  Use your best judgment and install the flow ring that you think will 
provide the correct airflow for the highest target pressure.  Don’t worry if you guess wrong, the 
program will instruct you to install a different ring later on if you start with the wrong one.  Click on 
OK after you’ve removed the inlet cover and installed the chosen flow ring.    

5. The operator is now prompted to indicate which flow ring was installed on the fan.  Select the 
appropriate ring and click on Proceed with Test. 

6. The fan will automatically turn on and increase speed until the building pressure reaches the highest 
target pressure line shown on the graph.1   The current fan airflow and building pressure is shown on 
the graph by the moving Fan Airflow and Building Pressure Cursor.  Once the appropriate target 
building pressure is achieved, TECTITE Express takes a number of simultaneous readings of building 
pressure and fan airflow.  Each reading is displayed on the graph as a small dot as it is collected.  Once 
the program is finished collecting readings for the first target pressure line, the average value of all 
readings for that target pressure is displayed as a red circle.  The fan speed is then reduced until the 
building pressure reaches the next lowest target pressure line and the data collection process is 
repeated.  Note:  If the Zonal Pressures feature has been activated from the Test Settings screen, the 
Zone Pressure status window will display the current measured zone pressure during the course of the 
automated test.  While TECTITE Express is collecting data for the building airtightness test (from 
Channels P1 and P2), it will also collect and store data from each active zone channel (P3 – P8).   

7. After data have been collected for the last target pressure line, the fan turns off and the operator is 
again prompted to cover the fan inlet for another set of baseline building pressure readings.   

8. All data are now automatically adjusted for the average of the two baseline readings, and the test is 
completed.  A “best fit” line is then drawn through the data points (i.e. red circles) on the graph. 

9. Calculated test results can be seen by clicking on Next. The measured zone pressure data are available 
from the Zone Data screen (click Next from the Test Results Screen, or use the Goto Menu Item). 

 

 
Using the Sample Button (manually activating data collection): 
 
The Sample button is used to manually activate data collection for a target building pressure line during an 
automated test sequence, rather than waiting for TECTITE Express to automatically activate data 
collection.  This button is particularly useful if it is windy and the building pressures are fluctuating causing 
a long time delay before automated data collection begins at each target pressure line. In addition, if you are 
conducting a Semi-Automated test, you must use the Sample button to initiate the data collection process. 
 
Using the Clear Button (Clearing Data From the Graph): 
 
The Clear button is used to clear all Blower Door data from the graph.  This will not affect the information 
that you have entered into the test input screens, or any results that you have previously saved.  Clear is 
typically used to prepare the graph for a new test.  Clicking on the Clear button will also clear all stored 
zone pressure data. 
 
Conducting and Displaying Multiple Tests on the Same Graph: 
 
Data from more than 1 automated test can be displayed on the Test Graph at one time.  This occurs when 
conducting a second airtightness test (using Start Test) and not clearing data before beginning the next test.   

                                                 
1   If the program is unable to reach the highest target pressure line with the fan running full speed, the operator will be 
prompted to change to the next larger flow ring.  If the fan is in open configuration and still not able to reach the 
highest target pressure line, the program will display the message “Can’t Reach Target Pressure...Collecting Data at 
Highest Building Pressure” (see Section below  - Operator Messages During the Automated Airtightness Test). 
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�  Multiple Tests With the Same Test Mode:  If data from multiple tests with the same test 
mode are displayed on the graph (for example, 2 depressurization tests), test results are 
calculated using all displayed data.  The main reason for combining multiple tests with the 
same test mode is to increase the repeatability of test results.  This is particularly useful in 
windy weather. 

 
�  Multiple Tests with Different Test Modes:  It is also possible in this version of TECTITE 

Express to collect and display both depressurization and pressurization data on the same 
graph.  A number of Blower Door test standards (EN 13829 and ASTM E779) require that 
tests be conducted using both modes.  If depressurization and pressurization tests are 
combined on the graph, test results for each mode will be displayed separately, as well as a 
combined result based on the average of both test modes. 

 
The Completed Tests indicator, located on the right-hand side of the Test Graph Screen, shows the total 
number of completed tests being displayed on the graph.   
 
Using the Pause Button: 
 
Once an automated test has been initiated, the Pause button can be used to temporarily pause the test 
sequence.  After clicking on Pause, the fan will turn off and the message  The Test Is Paused  appears on 
screen.  From this message box, the user has 3 options: 
 

�  Clicking on Adjust Auto Test Settings allows you to change the Fan Adjust Rate, the Target 
Tolerance, the Building High Pressure Limit and the Fan Start % fields during the middle of 
a test.  

 

�  Clicking on Proceed With Test will restart the test sequence from where the Pause button 
was activated. 

 

�  Clicking on Stop Test allows you to end the current test sequence.  
 

 

7.5  Stopping an Automated Test 
 
In addition to using the Pause button, the fan can be quickly turned off during a test by pressing the Esc 
key, or by clicking on the Stop Test button.  After the fan has been turned off, the user can choose to end 
the current test sequence, or can restart the test.  If data from more than one test are being displayed on the 
graph, stopping a test will not clear data from previously completed tests.  In addition, stopping a test will 
not affect information that you have typed into the test input screens, or any test results that you have 
previously saved. 
 

 

7.6  Adjusting the Auto Test Parameters  
 
The Test Settings screen contains a number of  Auto Test Parameter fields which are used to adjust data 
collection and fan control variables during the automated test sequence.  Refer to Chapter 6 for a detailed 
description of each of the Auto Test Parameter fields.  As noted above, the Auto Test Parameters can 
also be adjusted in the middle of a test sequence by clicking on the Pause button. 
  

 

7.7  Operator Messages During the Automated Test 
 
During the airtightness test, TECTITE Express provides a series of on-screen messages or prompts to the 
operator to ensure that proper testing procedures are followed.  In addition, the program detects common 
testing or equipment problems (e.g.  tubing connected to the wrong pressure tap) and provides a warning 
message to the operator.  On the following pages is a listing of on-screen test procedure and operator 
warning messages provided by the TECTITE Express program: 
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On- Screen Procedure Messages    Operator Action Required    
Cover fan inlet to measure starting 
building pressure baseline.  Press OK 
when ready.            or 
 
Cover fan inlet to measure ending building 
pressure baseline.  Press OK when ready. 

Cover the fan inlet so that TECTITE Express can measure the baseline 
building pressure (due to wind and stack effects) prior to, or following 
completion of the test.  Install either the no-flow plate or the nylon fan 
cap to seal off the fan inlet opening.  

Remove fan inlet cover and install 
appropriate flow ring.  Press OK when 
ready. 

Remove the no-flow plate or nylon fan cap from the fan inlet so that the 
fan can be turned on.  Install the flow ring that you think will provide the 
appropriate air flow for the beginning of the test. 

Which flow ring is installed? Select the flow ring that is currently installed on the fan, and then click on 
Proceed with Test. 

Install Ring _  and press here to continue 
test,  OR   Press here to end test at 
previous test pressure.  

The program has determined that a different flow ring should be installed 
on the fan.  Install the ring listed in the message.  If the listed ring is not 
available, or you wish to end the test at this point, click on the end test 
message.2 

Remove all rings and press here to 
continue test,  OR   Press here to end test 
at previous test pressure.   

The program has determined that all flow rings should be removed from 
the fan.  Remove all rings from the inlet of the fan.  You may also select 
to end the test at this point.   

This will end testing.  Do you wish to end 
it?                         or      
 
This will end cruising.  Do you wish to end 
it?   

This message appears when you have pressed Esc or clicked on Stop Test 
during a test, or while the cruise control feature is active.  To end the test 
or turn off cruise control, click on Yes. 

 
On-Screen Warning Messages     Operator Action Required 
Can not reach target pressure and have 
open fan.  Collecting data at highest 
building pressure. 

No action required.  If the fan is in open configuration (i.e. no flow plates 
installed), running at full speed, and not able to reach the target pressure 
line, TECTITE Express will automatically collect data at the highest 
achievable building pressure. 

Warning:  Wrong sign (+/-) on building 
pressure.  Check A/P1.  Do you wish to 
terminate test? 

The measured building pressure on Channel A/P1 is changing in the 
wrong direction from the indicated Test Mode.  Check to be sure the A/P1 
Reference tap is connected to the outside, the A/P1 Input tap is measuring 
the pressure inside of the building, and that the direction of the Blower 
Door fan flow is consistent with the indicated Test Mode (i.e. 
depressurization vs. pressurization). Click on Yes to end the test and No 
to continue the test. 

Warning:  Wrong sign (+/-) on fan 
pressure.  Check B/P2.  Do you wish to 
terminate test?  

The measured fan pressure on Channel B/P2 is changing in the wrong 
direction.  Check to be sure the B/P2 Input tap is connected to the Blower 
Door fan, and the B/P2 Reference is measuring the pressure in the space 
upstream of the fan inlet.  Click on Yes to end the test and No to continue 
the test. 

Warning:  Not detecting fan pressure.  
Check B/P2.  Press OK to terminate test.    
 
 
 

The measured fan pressure on Channel B/P2 is less than 1 Pa, but the 
building pressure is changing.  Possible fan pressure tubing disconnect.  
Check to be sure the B/P2 Input tap is connected to the Blower Door fan, 
and the B/P2 Reference is measuring the pressure in the space upstream 
of the fan inlet. Click on OK to end test. 

Warning:  Not detecting fan or building 
pressure.  Check system.  Press OK to 
terminate test. 

The program is not detecting a fan or building pressure reading, even 
though the program is calling for full fan speed.  Check building and fan 
pressure tubing connections to the DG-700/DAB.  If the fan was not 
running, check the fan speed controller to make sure:   
- It is properly connected to the fan and plugged into power.   
- The speed control knob is turned on. 
- The speed controller is connected to the DG-700/ DAB. 
Click on OK to end test. 

                                                 
2  If you end the test and data has been collected for at least one previous target pressure line, test results will be 
calculated using all data collected prior to ending. 
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On Screen Warning Messages   Operator Action Required 
Warning:  At full fan speed but <2 Pa 
building pressure.  Check system.  
Press OK to terminate test.  

The measured building pressure on Channel A/P1 is less than 2 Pa when the 
fan is at full speed.  First check that the A/P1 Reference tap is connected to 
the outside, and the A/P1 Input is measuring the pressure inside of the 
building.  Second, check that outside windows and doors in the building are 
closed and that there are no other large openings to the outside preventing 
the building pressure from changing. Click on OK to end test. 

Warning:  Not detecting building 
pressure on A/P1. 

The program is not detecting a change in building pressure, even though the 
fan pressure is at least 50 Pa.  Check that  one end of the (green) building 
reference tubing is connected to the A/P1 Reference tap, and that the other 
end is placed outside of the building and away from the Blower Door fan 
flow.  Click on End Test to terminate test. 
 
Advanced Users:  If you are conducting an advanced  procedure where you 
are trying to maintain or measure very small (or zero) building pressures 
(e.g. “cruising zero”), you can  temporarily turn off this message by checking 
the Turn off this warning  box. 

Warning:  Excessive building pressure 
fluctuation for the current target 
pressure.   

While attempting to reach a target pressure line, the measured building 
pressure has been fluctuating beyond the Target Tolerance for more than 90 
seconds.  To determine the cause of the fluctuating building pressure 
problem, and the appropriate operator action,  see Chapter 15 – Problem 3.  
To make changes to the auto test settings, click on Adjust Auto Test 
Settings, to proceed with the test, click on Proceed with Test, or to end the 
test, click on Stop Test. 

Warning:  Maximum allowable 
building pressure exceeded. 

The default maximum allowable measured building pressure is 90 Pascals.  
This maximum pressure is designed to prevent accidental damage to the 
building being tested.  In addition, calibration formulas for the Blower Door 
fans may not be accurate at back pressures greater than 90 Pascals, 
depending on the flow ring installed and the fan pressure.   
 
If you set the Fan Start % setting too high, the fan will begin operation at a 
high speed and may inadvertently trigger this warning.  Reduce the Fan 
Start % setting if this occurs. In addition, lowering the Fan Adjust Rate 
setting may also help to prevent this message inadvertently being triggered 
(the Fan Start % and Fan Adjust Rate can be changed by clicking on the 
Adjust Auto Test Settings button in the warning screen).  To proceed with 
the test or cruise procedure, click on Proceed with Test/Cruise, or to end 
the procedure, click on Stop Test/Cruise.. 

No test pressures available.  No test pressures have been selected in the Test Pressures field in the Test 
Settings screen.  Automated testing can not begin until test pressures have 
been entered, or the default pressure setting is selected. 

Data for more than one test will be 
combined on the graph. 

Data from more than 1 automated test with the same test mode can be 
combined and displayed on the Test Graph at one time.  This occurs when 
conducting a second airtightness test (using Start Test) and not clearing 
data before beginning the test.  The main reason to combine data from 
multiple automated tests (with the same test mode) is to increase the 
repeatability of the test results in windy weather. 
 
If you start a new test while data are currently displayed on the graph, a 
warning message appears to let you know that you are attempting to combine 
data from multiple tests.  If you would like to save the current test data to a 
file before adding additional data points, you will need to select Cancel Test 
and save the data file before proceeding.  
 
Note:  This warning message does not appear if you are simply combining 
tests with different test modes (e.g. a single depressurization test with a 
single pressurization test).  If depressurization and pressurization tests are 
combined on the graph, test results for each mode will be displayed 
separately, as well as a combined result based on the average of both modes. 
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On Screen Warning Messages             Operator Action Required 
Communication lost.  Testing ended. 
 
                             or 
 
Communication lost.  Cruising ended. 

Communication between the DG-700/DAB and your computer have been 
disrupted, and the current test or cruise procedure has been ended.  If you 
were conducting an airtightness test when communication was lost, the test 
sequence is ended and all data from the current test are cleared from the 
graph.  
 
Note:  If the fan is still running, it can be stopped by completely turning off 
the knob on the fan speed controller. 
 
Lost communication can be caused by a poor connection between the DG-
700/DAB and your computer, or by a loss of power to the DG-700/DAB.  
Check the serial cable between the computer and the DG-700/DAB, and 
check to be sure the DG-700/DAB is turned on.  If you are unsure if the 
DAB’s internal battery is charged, plug in the power supply to the DAB.  
Click on OK to return to the Test Graph screen.  See Chapter 15 for more 
information on lost communications. 

Warning:  Flow too small to measure.  
Press OK to terminate test.   

You are trying to measure a fan flow below the acceptable operating range 
of the equipment.  Click on OK to end the test. 

Cannot start the test because there are 
not enough pressure channels for the 
existing test data.  Do you wish to 
clear the data, deactivate Zonal 
testing, and proceed with the test? 

You are trying to combine data for more than 1 test, and the current DAB 
being used has fewer pressure channels than were used during the first test.  
For example, this message would appear if a 5 pressure channel DAB was 
used to record 3 zone pressures during the first test, and you are now using a 
4 pressure channel DAB to combine data with the first test.  Click on Yes to 
clear all existing test data, deactivate the zonal testing feature, and proceed 
with a new test, or click on No to end the current test sequence.  

Warning: Data box due for re-
calibration. 

The DG-700/DAB should be re-calibrated once per year.  If it has been more 
than 1 year since the last calibration (based on your computer’s internal 
clock), this message will appear.  The calibration date for your DG-
700/DAB can be found on the calibration sticker located on the bottom of 
the unit, or click on Data Box Info from the Test Graph (Auto Method) 
Screen.   

Low Battery Warning.  Press OK to 
end procedure. 

TECTITE Express has detected that the DG-700 or APT DAB battery is low.  
The user is advised to end the current test sequence and take the following 
action: 
 
DG-700 
Replace the 6 AA batteries (located in the compartment in the back of the 
instrument) before resuming testing.  Be sure the gauge is turned off before 
replacing the batteries.  The low battery warning is activated if TECTITE 
Express detects a battery voltage below 5.5 volts. The current DG-700 
battery voltage can be viewed by clicking on the Data Box Info button.  
 
APT DAB 
Plug in the power supply to the DAB.  You may need to let the DAB’s 
internal NiCd battery charge for 20-30 minutes before resuming testing.  The 
fully charged NiCd battery will power the DAB for approximately 6 - 12 
hours of testing.  If you are using your APT DAB for the first time, we 
recommend that you fully charge the DAB battery overnight before 
beginning testing.  The DAB can be also be operated with the power supply 
plugged in.  A green light located next to the 12V terminal on the DAB will 
turn on whenever the power supply is providing power.  The DAB's battery 
will charge even when the DAB is in operation, however the time required to 
fully charge the battery is increased. 
 
Click on OK to return to the Test Graph. 
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7.8  Manually Adjusting the Fan Speed 
 
The fan speed can be manually adjusted by dragging the manual fan speed control slider on the Test Graph 
screen, or by pressing down on the Up and Down arrow keys.  In order for the fan speed control slider to 
work, a communication link between the computer and DG-700/DAB must have been established, and the 
message Idle - Monitoring  should appear in the DAB Status Window.  
 
If you are conducting a Semi-Automated test, the manual fan speed control slider is not available, and you 
will need to manually turn the Blower Door fan speed controller knob in order to adjust the fan speed. 
 
 
7.9  Real-Time ACH50 Estimator 
  
During Idle - Monitoring  (or when the Cruise Control feature is active), TECTITE Express can display a 
real-time estimate of Air Changes per Hour at 50 Pascals of building pressure in the ACH50 Estimator 
Window.  To estimate ACH50, TECTITE Express uses the current measured fan flow, the volume estimate 
input into the Building Information screen, and an assumed Building Leakage Curve exponent (n value) of 
0.65.  The ACH50 estimator window is only active when the current building pressure is between 40 and 60 
Pascals, and a valid fan flow measurement is being made.  The Real-Time ACH50 display is useful for 
quickly estimating building leakage rates before conducting a full airtightness test.  
 
Note:  The Real-Time ACH50 estimator is not active during an automated test sequence. 

 
Real-Time ACH50 Estimator 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ACH50 Estimator Window 
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7.10  Using the Display Large Meters Feature 
 
The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) screen with 3 large 
status windows showing Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The feature 
can be toggled on and off by clicking on Display Large Meters from the Options Menu. 
 
 
 
 
 
 
 
 
 
The Display Large Meters feature is particularly useful when looking at the computer screen from a distance 
while “Cruising” or manually adjusting the Blower Door fan in Idle-Monitoring  mode.  The Real-Time 
ACH50 Status Window is only active when the current building pressure is between 40 and 60 Pascals, and 
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an 
automated test sequence. 
 

Display Large Meters Feature 
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Chapter 8     Using the Manual Data Entry Method   
 
 
8.1  Overview of Test Graph Screen (Manual Method) 
 
Manual Method is used to input Blower Door test data (e.g. building pressure and fan airflow readings) that 
were collected manually, rather than collected automatically by TECTITE Express.  The Manual Method 
option is only available if the Method field is set to Manual from the Test Settings screen 
 
The figure below shows the Test Graph screen when using Manual Method.  Like the Auto Method Test 
Graph screen, the main feature of the Manual Method Test Graph screen is a plot of Blower Door fan 
airflow (or building leakage) on the vertical axis versus building pressure on the horizontal axis.  However, 
when using Manual Method, all auto control buttons and status windows have been removed, and replaced 
with a Data Table button which opens a simple data entry table.  Test data entered into the Data Table are 
plotted on the graph, and a best-fit regression line is automatically drawn through the plotted data points.  
 

Test Graph Screen (Manual Method) 

 
 
8.2  Selecting the Fan Model 
 
Before entering data into the Data Table, select the Blower Door fan model being used for the test.  To 
select the fan model, click on Options located in the Main TECTITE Express Menu.  From the Options 
Menu, select Equipment Info.  In the Equipment Information window, select the appropriate fan model 
from the pull-down list.  
 
You may also input a fan serial number which will be stored along with the building test file, and is printed 
out on the detailed test report.  In addition, when conducting a Manual test, you can also input and store a 
micromonometer (gauge) serial number and custom calibration date.  If you are conducting an Automated 
or Semi-Automated test, the TECTITE Express software automatically stores the micromonometer serial 
number and calibration date as part of the building test file. 
 
 

Button to access manual 
entry Data Table.  

Pressure difference between inside 
and outside (Building Pressure) 
 

Flow through the 
Blower Door fan 
(Building 
Leakage) 
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Equipment Information Window (Manual Test) 

 
Note:  If you change the selected fan model while test data are displayed on the graph, the test data will be 
automatically cleared from the graph and the Data Table.   
 
 
8.3  Entering Test Data into the Data Table 
 
The Data Table screens allow entry of either (or both) depressurization and pressurization test readings by 
clicking on the appropriate tab at the top of the screen. In addition, baseline building pressures and 
environmental test data (temperatures, altitude, barometric pressure) are also entered from the Data Table. 
 
Each Table allows entry of up to 12 sets of Blower Door test readings (arranged in rows).  You can move 
through the Table using the Tab key, or by clicking on the individual entry fields.  You may input as few as 
1 and as many as 12 sets of test readings.  For each set of test readings, you must enter the measured 
building pressure (in Pa), the fan configuration corresponding to this set of readings (i.e. which Flow Ring 
was installed on the fan), and the measured fan flow used to generate the building pressure.  Fan flow can 
either be entered directly (by choosing the Flow button in the Flow Data Source field), or by entering the 
fan pressure signal in Pascals (by choosing the Fan Pressure button in the Flow Data Source field).  If you 
enter the fan pressure signal, the flow value will be automatically determined by TECTITE Express.  If you 
input fewer than 12 sets of readings, simply leave the remaining rows empty.   
 
Note:  Be sure to enter flow values in the same units chosen in the Units Selection window. 
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Data Table for Manual Entry of Test Readings (CGSB Test Standard) 

 

 
Data Table for Manual Entry of Test Readings (E779-10 Test Standard) 

 
Data Table for Manual Entry of Test Readings (EN 13829 Test Standard) 
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Entering Baseline Readings into the Data Table: 
 
The baseline building pressure is the pressure between the building and outside before the Blower Door fan 
is turned on.  Use of baseline pressure readings in the Table allows the program to quickly adjust the 
manually collected test readings for baseline stack and wind effects.  The process for entering the baseline 
pressure readings depends on which Test Standard is selected on the Test Settings screen. 
 

�  Entering Baseline Readings for a CGSB Test. 
 

Begin data entry by manually inputting a Pre-Test Baseline reading in Pascals. If you wish to 
input an optional Post-Test baseline reading, enter it following data entry of all the test readings in 
the Table.  If you leave the Post-Test Baseline field empty, the program will simply use the pre-
test reading when adjusting for baseline pressure effects. 
 
Note:  If you are using the DG-700’s built-in Baseline feature, enter 0 into the Pre-Test Baseline 
field (you may leave the Post-Test Baseline field blank).  This is because the DG-700’s Baseline 
feature has already adjusted the building pressure reading(s) for baseline effects. 

 
�  Entering Baseline Readings for an E779-10 Test.  

 
Begin data entry by manually inputting a Pre-Test Baseline reading in Pascals.  Input a Post-Test 
Baseline reading following data entry of all the test readings in the Table.  The E779-10 test 
standard requires both a pre and post test baseline reading to be entered.   
 
Note:  If you are using the DG-700’s built-in Baseline feature, enter 0 into both the Pre and Post 
Test Baseline fields.  This is because the DG-700’s Baseline feature has already adjusted the 
building pressure reading(s) for baseline effects. 

 
�  Entering Baseline Readings for an EN 13829 Test. 

 
Standard EN 13829 requires that baseline building pressures be made both before (Pre-Test) and 
after (Post-Test) the test readings are taken with the Blower Door fan operating.  Click on the 
Enter/Edit Baseline button to open a separate EN 13829 Baseline Data Entry screen.   

 
EN 13829 Baseline Data Entry Screen 
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From the EN 13829 Baseline Data Entry window select the baseline data source: 

 

Individual Readings:    Choose this option if you will be manually collecting a sequence of 
baseline pressure readings.  When this option is chosen, the Baseline Data Entry screen 
contains 2 data entry windows for the sequence of baseline pressure measurements (one for 
the Pre-Test readings, and one for the Post-Test readings).  For each data entry window, enter 
a sequence of measured baseline building pressures taken over a time period spanning at least 
30 seconds.  Enter only one reading on each line of the data entry window.  Be sure to include 
the proper sign (+ or -) for each reading.  TECTITE Express will automatically calculate the 
quantities p(avg), p0(+), and p0(-) based on your entries.  Once you have completed your 
entries for either Pre-Test or Post-Test baseline data, click OK to return to the Manual Data 
Entry Screen.  Click on Clear Data to clear all baseline data entries you have made in the data 
entry windows. 

 
DG-700 (PR/ EN Mode):   Choose this option if you are using the DG-700’s PR/ EN mode to 
measure and calculate p(avg), p0(+), and p0(-).  When this option is chosen, directly input 
p(avg), p0(+), and p0(-) into the appropriate Pre-Test and Post-Test fields.  Once you have 
completed your entries for either set of fields, click OK to return to the Manual Data Entry 
screen.  Click on Clear Data to clear all baseline data entry fields. 

 

 
Entering Environmental Data into the Data Table: 
 

�  CGSB Test:  Click on the Enter/Edit Temperature Data button to enter the Inside and 
Outside temperatures during the test.  

 
�  E779-10 Test:  Click on the Enter/Edit Temperature and Altitude Data button to enter the 

Inside and Outside temperatures during the test, and the site altitude for the building being 
tested. 

 
�  EN 13829 Test:  Click on the Enter/Edit Temperature and Barometric Pressure Data 

button to enter the Inside and Outside temperatures during the test, and the site barometric 
pressure.  

 

 
Additional Tips on Using the Manual Data Entry Table: 
 

�  Be sure you have the gauge set up properly (refer to your Blower Door or digital gauge 
manual).  If you have set the gauge up properly, building pressure readings will be read from 
Channel A, and fan flow readings will be read from Channel B. 

�  If you are using the DG-700’s BASELINE feature, enter 0 into the Baseline fields.  This is 
because the DG-700’s BASELINE feature has already adjusted the building pressure 
reading(s) for baseline effects.   

�  If you are using the DG-700’s @50 feature to conduct a simple one-point test, always enter the 
building pressure as 50 Pa.  This is because the @50 feature automatically adjusts the 
displayed flow reading to a test pressure of 50 Pa. 

�  Be sure to include the proper sign of all baseline readings. 
�  If you are Depressurizing the building, enter the building pressure readings as negative 

numbers (TECTITE Express automatically places a negative sign in the building pressure 
entry fields if the Test Mode is set to Depressurize). 

�  If you are Pressurizing the building, enter the building pressure readings as positive readings. 
 
When you are finished entering test data into the Table, click on OK to return to the Test Graph.  You can 
clear the Table at any time by clicking on the CLEAR DATA button. 
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Chapter 9    Viewing Test Results  (Auto and Manual Method ) 
 
 
Once an automated test has been completed, or test data have been manually entered into the Data Table, 
test results are automatically calculated using all data points displayed on the graph, and values input into 
the building and climate screens.  To view the Test Results screen, click on Next from either Test Graph 
screen.  

Test Results Screen (CGSB Standard with Single Test) 

 
Note:  If the building test file contains test data using both test modes (e.g. depressurization and 
pressurization tests), test results for each mode will be displayed separately, as well as a combined result 
based on the average of both modes. 
 

 
9.1  Overview of Test Results Screen 
 
Airflow At 50 Pascals:      
      

�  Flow at 50 Pascals (V50):  This is the airflow needed to create a change in building pressure 
of 50 Pascals, and is the most commonly used measure of building airtightness.      

      
�  ACH at 50 Pascals (n50):  The Air Changes per Hour at 50 Pascals is another commonly 

used measure of  building airtightness.  ACH at 50 Pascals is the number of complete air 
changes that will occur in one hour with a 50 Pascal pressure being applied uniformly across 
the building envelope.  ACH at 50 Pascals is a useful method of adjusting (or normalizing) the 
building leakage rate by the size (volume) of the building.  If you did not enter the building 
volume on the Building Test Info screen, ACH at 50 Pascals will not be calculated.   

      
�  Flow at 50 Pascals / unit Floor Area (w50):  This is the Flow at 50 Pascals divided by the 

entered floor area of the building.  This calculation adjusts (or normalizes) the building 
leakage rate by the floor area of the building.  If you did not enter the floor area on the 
Building Test Info screen, this variable will not be calculated.      
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�  Flow at 50 Pascals / unit Surface Area (q50):  This is the Flow at 50 Pascals divided by the 

entered surface area of the building.  This calculation adjusts (or normalizes) the building 
leakage rate by the surface area of the building.  If you did not enter the surface area on the 
Building Test Info screen, this variable will not be calculated. 

      
Changing the Airflow Test Reporting Pressure:  TECTITE Express uses a default airflow test 
reporting pressure of 50 Pascals.  The airflow reporting test pressure can be changed using the 
drop down list in the Airflow section of the Test Results screen.  Test pressures of 75 Pa, 50 Pa, 10 
Pa and 4 Pa are available from the drop down list.  Changing the reporting pressure on the Test 
Results screen will also change the reporting pressure in the Test Report. 

 

 
Leakage Areas:      
      
Once the leakage rate for the building has been measured, it is useful to estimate the cumulative size of all 
leaks or holes in the building's air barrier.  The estimated leakage areas not only provide us with a way to 
visualize the physical size of the measured holes in the building, but they are also used in infiltration models 
to estimate the building's natural air change rate (i.e. the air change rate under natural weather conditions).    
 
The Results screen includes two leakage area calculations, based on differing assumptions about the 
physical shape of the hole, which are compatible with the two most commonly used infiltration models.  In 
addition, both leakage area estimates are shown normalized by the entered surface area of the building.    
      

�  Equivalent Leakage Area (EqLA):  EqLA is defined by Canadian researchers at the 
Canadian National Research Council as the area of a sharp edged orifice (a sharp round hole 
cut in a thin plate) that would leak the same amount of air as the building does at a pressure of 
10 Pascals.  The EqLA is used in the AIM infiltration model (which is used in the HOT2000 
simulation program). 

      
�  Effective Leakage Area (ELA):  ELA was developed by Lawrence Berkeley Laboratory 

(LBL) and is used in their infiltration model.  The Effective Leakage Area is defined as the 
area of a special nozzle-shaped hole (similar to the inlet of your Blower Door fan) that would 
leak the same amount of air as the building does at a pressure of 4 Pascals.    

      
Note on Leakage Areas: When using leakage area calculations to demonstrate physical changes 
in building airtightness, we recommend using the EqLA measurement.  Typically, EqLA more 
closely approximates physical changes in building airtightness.  For example, if you performed a 
Blower Door test, and then opened a window to create a 50 square inch hole and repeated the test, 
the estimated EqLA for the building will have increased by approximately 50 square inches from 
the initial test results.      

      

 
Building Leakage Curve:      
      

�  Air Leakage Coefficient (C) and Exponent (n):  Once an automated airtightness test 
sequence (or manual entry of data into the table) has been completed, a "best-fit" line (called 
the Building Leakage Curve) is drawn through the collected Blower Door data.  The Building 
Leakage Curve can be used to estimate the leakage rate of the building at any pressure.  If you 
have conducted a single point test, the program assumes an exponent (n) of 0.65 in its 
calculation procedures.3    

                                                 
3   The assumed exponent value of 0.65 is a typical value for residential construction. 
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The Building Leakage Curve is defined by the variables Coefficient (C) and Exponent (n) in the 
following equation:   

 

  Q = C x Pn     
  where:      
  Q  is airflow into the building.      
  C  is the Coefficient.      
  P  is the baseline adjusted pressure difference between inside and outside the building.      
  n  is the Exponent.           
 
  Example:  Use the Building Leakage Curve to estimate the exhaust fan airflow in a  
  building needed to create a 5 Pa negative pressure.  From our Blower Door test we  
  determined the following Building Leakage Curve variables.       
      
  C = 110.2 (CFM)   n = 0.702    From the equation above:   
 
  Airflow (at 5 Pa) =  110.2 x 5^.702  =  341 CFM.  In other words, we estimate from  
  the Building Leakage Curve that it would take exhaust fans with a combined capacity  
  of 340 CFM to cause a 5 Pa pressure change in this building.        
 

�  Correlation Coefficient:  The correlation coefficient is a measure of how well the collected 
Blower Door data fit onto the "best-fit" Building Leakage Curve.  The closer all data points 
are to being exactly on the Building Leakage Curve, the larger the calculated correlation 
coefficient (Note:  the largest possible value for the correlation coefficient is 1.0).  Under most 
operating conditions, the correlation coefficient will be at least 0.99 or higher.      

   
Testing in very windy weather can sometimes cause the correlation coefficient to be less than 
0.99.  In this case, you may want to repeat the test, or increase the number of Samples Per 
Station.  Achieving a correlation coefficient of 0.99 or higher is particularly important in the 
estimation of Leakage Areas, or when using the Building Leakage Curve to estimate leakage 
rates at low building pressures.       

 
 
9.2  Deviations from Standards Screen 
 
The Deviations from Standard screen is accessed by clicking on Next from the Test Results screen.  This 
screen lists aspects of the current test data that deviate from the selected Test Standard. 
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Note:   If you are conducting an automated test, and are measuring zone pressures during the Blower Door 
test, the Zone Data screen will appear before the Deviations from Standards screen.  The Zone Pressure 
feature of TECTITE Express is discussed in more detail in Chapter 10.   
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Chapter 10    Measuring Building Zone Pressures  
 
 
Many important air leaks in a building are not direct leaks to the outside.  Indirect air leaks, or “series 
leaks”, often follow complicated paths through building cavities and through unconditioned zones  (such as 
attics, crawlspaces or garages) on their way into or out of the building.  Attic bypasses are a good example 
of a series leak.  Air leaving the house first must flow through the ceiling/attic boundary and then through 
the attic/roof boundary before exiting the house.    
 
Diagnostic procedures have recently been developed to help analyze series leakage paths in buildings. 
These diagnostic procedures, usually called pressure diagnostics, combine standard Blower Door 
airtightness tests with building zone pressure measurements to help prioritize airsealing activities.  The 
TECTITE Express program can be used to automate the measurement of building zone pressures during a 
building airtightness test.  The zone pressure test results can then be used directly as a performance 
measurement, or as inputs into a separate series leakage analysis program (such as the ZPD Calculation 
Utility program available at no charge from The Energy Conservatory - www.energyconservatory.com). 
 
 
10.1  Using the Zonal Pressure Measurement Feature 
 
In order to make use of TECTITE Express’s zonal pressure measurement feature, TECTITE Express must 
be able to establish a communication link with Device(s) containing a total of 3 or more installed pressure 
channels. We need at least 3 pressure channels because 2 of the channels (from the Primary Device) are 
already being used to measure the building pressure and Blower Door fan flow.  For example, if your 
Primary Device is an APT DAB with 5 installed pressure channels, you would be able to use pressure 
channels P3, P4 and P5 on this Device to measure up to 3 zone pressures by activating P3, P4 and P5 in the 
Zonal Pressures Set-Up screen.  On the other hand, if your Primary Device is a DG-700 gauge, then you 
will need to use one or more Aux Devices to utilize the Zonal Pressures feature.  For example, if you use 
one additional Aux DG-700, you would be able to use the two pressure channels from this Device to 
measure up to 2 zone pressures by activating P3 and P4 in the Zonal Pressures Set-Up screen. 
 
To activate the zonal pressure feature, first click on the Active button in the Zonal Pressures field on the 
Test Settings screen.  Now click on the Settings button to bring up the Zonal Pressures Set-Up screen.  
 

Zonal Pressures Set-Up Screen 
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From this screen you can configure TECTITE Express to measure zonal pressures during the automated 
airtightness test.  For each installed pressure channel that you want to use, click on the appropriate check 
box under “Activate”.  Edit the corresponding Zone Name field with a descriptive label for the zone being 
measured.  Now choose the reference pressure location for that zone in the “With Reference To” field.  
When choosing the reference pressure location for a zone, we recommend that you choose “outside” if the  
zone being measured is intended to be better connected to the outside (such as in the case of a vented attic, 
or a garage), or choose inside if the zone is intended to be better connected to the inside (such as in the case 
of most basements).  
 
The information that you have entered on the Zonal Pressure Set-Up screen will be stored when you save a 
test file or a configuration file.  You may wish to make zonal pressure set-up part of your default 
configuration file (see Chapter 14 for information on creating and using configuration files).  Once you 
have completed the Zonal Pressure Set-Up screen, click on OK to return to the Test Settings screen.   
 
 
10.2  Taking and Storing Zone Pressure Measurements 
 
Once the Zonal Pressures feature has been activated and the Set-Up screen completed, zone pressure status 
windows will appear at the top of the Test Graph screen (Auto and Semi-Auto Methods).  Active status 
windows will only appear for pressure channels that have been activated in the Set-Up screen and are 
communicating properly with a TEC Device.  For each active status window, the channel and serial number 
of the Device being used to monitor the zone pressure is listed to the left of the window.  If the status 
windows are blank and either of the following two messages appear in the DAB Status Window at the 
bottom of the Test Graph screen (Insufficient Channels for Test, or Aux Device IS NOT 
CONNECTED), refer to Chapter 15 for help on troubleshooting your communication/setup problem. 

 
Zone Pressure Status Windows 

 
 

 
 
Before beginning your airtightness test, you will need to connect tubing to the pressure channels being used 
to measure zone pressures.  The first step is to connect tubing between the zone being monitored and the 
appropriate Input tap on the DG-700 or DAB.  You will also need to connect the Reference pressure tap for 
each zone channel to the reference space that you have designated in the Zonal Pressure Set-Up screen (i.e. 
outside or inside).   For example, if you have set up a channel to measure attic pressure with reference to 
outside, you will need to connect the channel reference tap to tubing running outside.    
 

Note:   If more than 1 channel is being referenced to the outside, you can run a single piece of 
tubing to the outside and use “T” connectors (along with short pieces of tubing) to connect the 
outside tubing to multiple reference pressure taps.   

 
To begin taking zone pressure measurements, you must initiate an airtightness test sequence by clicking on 
the Start Test button.  Zone pressure measurements, including baseline zone pressures, are taken at the 
same time that TECTITE Express is collecting building pressure and fan flow measurements for the 
airtightness test.  For example, if you are conducting a standard CGSB airtightness test procedure at 8 
separate target building pressures, TECTITE Express will collect 8 sets of zone pressure measurements, 

Attic Crawlspa Garage 
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along with a pre-test and post-test baseline measurement.  The number of samples taken at each target 
pressure for the zone pressure channels is determined by the Samples Per Station field on the Test Setting 
screen. 
 

Note:  Zonal pressures displayed in the status windows are adjusted for their current baseline zone 
pressure readings.  During a test sequence, numbers only appear in the zone pressure status 
windows during data sampling.  

 
 
10.3  Viewing Zone Data 
 
Once the automated Blower Door test is completed, the measured zone data are shown on the Zone Data 
screen.  To view the Zone Data screen, click on Next from the Test Graph screen, or choose Zone Data 
from the Goto Menu. 

 
Zone Data Screen 

 
 
10.4  Overview of Zone Data Screen 
 
The left side of the Zone Data screen contains a graph of measured zonal pressure (y-axis) versus house 
pressure (x-axis).  The pressure data points shown on the graph are not adjusted for measured baseline 
zones pressures, and the baseline pressure measurements themselves are included on the graph.  Each data 
point shown on the graph is an average of all samples taken for that zone at a particular target building 
pressure.   Data for an individual zone can be temporarily removed from the graph by clicking on the zone 
name or the check box next to the name.  The graph is automatically re-scaled to accommodate all active 
zone channels.    
 
The columns to the right of the graph provide summary data for each zone.  The summary data can be used 
directly as a performance measurement, or as inputs into a separate series leakage analysis program.   
 
House to Zone @ 50 Pa:   This is the estimated change in house to zone pressure (in Pascals) that would 
occur when the house to outside pressure is changed by 50 Pascals, based on a linear relationship between 
house pressure and zone pressure.    
 
Zone to Outside @ 50 Pa:   This is the estimated change in zone to outside pressure (in Pascals) that 
would occur when the house to outside pressure is changed by 50 Pascals, based on a linear relationship 
between house pressure and zone pressure.    

+/- 
Zone  

+/- 
Pressure 



 
Chapter 10   Measuring Building Zone Pressures 

TECTITE Express  
Version 4.0 

46 

  
+/-:   The third numerical column is the estimated repeatability of the House to Zone @ 50 Pa, and the 
Zone to Outside @ 50 Pa estimates.   If you were to repeat this test under the same building setup and 
weather conditions, the new results would not likely differ by more than the estimated repeatability. 
 
Pressure Ratio:   This is the Zone to Outside @ 50 Pa estimate divided by 50.  The Pressure Ratio will 
almost always be a number between 0 and 1.  If the Pressure Ratio is between 0.0 and 0.5, then the zone 
being measured is better connected to outside than inside.  If the Pressure Ratio is between 0.5 and 1.0, then 
the zone being measured is better connected to inside than outside.  As a simple memory aid:  remember 
that “0 = Outside” and “1 = Inside”. 
 

Example Pressure Ratios 

+/-:   The fifth numerical column is the estimated repeatability of the Pressure Ratio.   If you were to 
repeat this test under the same building setup and weather conditions, the new Pressure Ratio would not 
likely differ by more than the estimated repeatability. 
 

Note:   If you have set up the pressure hoses to your DAB correctly, the House to Zone @ 50 and 
Zone to Outside at 50 estimates will almost always appear as positive numbers, whether you are 
depressurizing or pressurizing the building.   If these estimates appear as negative numbers, you 
have probably connected the hoses incorrectly, or have designated the wrong reference location in 
the Zone Pressure Set-Up Screen.   

 
 
10.5  ZPD Input Table 
 
If you are using The Energy Conservatory’s ZPD Calculation Utility program to estimate air leakage rates 
from zones monitored during an automated Blower Door test, the ZPD Input Table contains all of the test 
data required to be input into the calculation utility program.  The ZPD Input Table can be found at the end 
of the Zone Data Report which is available from the main File menu (see Chapter 12  Printing Test 
Reports for more information).  The ZPD Input Table is not displayed on the Zone Data Screen. 
 
 
 
 
 
 
 

House to Zone @ 50 Pa Zone to Outside @ 50 Pa Pressure Ratio 
50 0      0.00 (zone is outside) 
49 1      0.02 
45 5      0.10 
40 10      0.20 
30 20      0.40 
25 25      0.50 
20 30      0.60 
10 40      0.80 
5 45      0.90 
1 49      0.98 
0 50      1.00 (zone is inside) 
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Chapter 11     Saving and Retrieving Building Test Files  
 
 
11.1  Saving Building Test Files 
 
Test files can be saved at any time by selecting File from the Main TECTITE Express Menu, and then 
clicking on  Save Current Test File which appears in the File Menu. 

 
Saved building test files contain all information entered into the Building Test Information, Comments and 
Test Setting Screens, as well as all test data shown on the Graph.  When saving a test file, you will need to 
enter a file name in the file save window that appears on screen.  You may also choose a different 
destination folder for the saved file by using the folder options appearing in the file save window.  All 
building test files are automatically given a .bld extension.   
 

Note:  If you want to create a PDF or Microsoft XPS file of the building test reports, refer to 
Chapter 12 Printing Test Reports.  Both PDF and XPS formats are “printed page” viewable files 
that display identically on all computers.  

 
 
11.2  Retrieving Building Test Files 
 
To retrieve a previously saved building test file for viewing, editing or printing, first select File from the 
Main TECTITE Express Menu, and then click on Retrieve Existing Test which appears in the File Menu. 

 
After selecting the Retrieve Existing Test option, a file select window will appear on screen which lists all 
the building (.bld) files contained in the current default folder.  To select a file, click on the file name from 
the list and then click on Open.  Once the file has been selected, the file information is loaded into the 
TECTITE Express program and the Building Test Info screen appears.  To change the folder being listed, 
use the folder options appearing in the file select window.   
 
 
11.3  Retrieving a Saved Test as the Starting Point for a New Test 
 
If you want to perform a repeat test at a building that you have previously tested, it is very convenient to 
start by retrieving the old test.  Choose Retrieve Existing Test from the File menu and select the old 
building test file.  As you go through the data entry screens, check for any information that has changed 
since the old test was performed. 
 
Importantly, when you get to the Test Graph screen click on the Clear Data button.  This clears the data on 
the Graph so that you can perform a new airtightness test.  Use of the Clear Data button will not affect the 
original building test file stored on your computer.  When you are done, save your new test using a new file 
name. 
 
Manual Method Users: 
 
When using the Manual data entry method, the data on the graph can be cleared by clicking on the Clear 
Data button from the Data Table window.
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Chapter 12      Printing Test Reports   
 
 
12.1  Printing and Preview Options 
 
Report printing and previewing options are available by clicking on File in the Main Menu.   

 
The TECTITE Express program includes a choice of two pre-formatted reports: a detailed Test Report and 
a Zone Data Report.  In addition, the airtightness Test Graph can be printed separately.  
 

Note: The report format is dependent on the test standard selected in the Test Settings screen.  In 
addition, the actual length of the Test Report and Zone Data Reports depend on the number of data 
points collected during the test.  

 
The detailed Test Report contains a complete listing of the building data, test data, test results, as well as 
any comments input into the Comment screen.  The Zone Data Report contains a listing of all measured 
zone pressures and estimated building to zone and zone to outside pressures at 50 Pascals of building 
pressure, as well as a graph of zone pressures versus building pressures.  The Zone Data Report is only 
available if the building test file currently loaded into TECTITE Express contains zone pressure data. 
 
The Test Graph is similar to the graph of fan airflow (or leakage) vs. building pressure from the Test Graph 
screen.  It can be used to visually estimate the relationship between air leakage and building pressure. 
 
The printing and preview functions within TECTITE Express utilize the printer drivers and configuration 
options currently installed in your computer.  
 

 
Creating a PDF or XPS File of the Test Reports: 
 
Both PDF and XPS files are “printed page” viewable files that display identically on all computers.  Both 
file formats can be created during the report printing process if your computer has the appropriate PDF or 
XPS file converter print drivers installed.  Once created, these files can be viewed on any computer that has 
PDF or XPS viewing software installed.  
 

�  Creating and Viewing a PDF File:  Many computers have PDF file converter programs pre-
installed.  In addition, there are numerous free PDF file converter programs available online. 
Two examples of free PDF file converters are Bullzip PDF Printer  (www.bullzip.com), and 
CutePDF Writer  (www.cutepdf.com).  Once installed, these free PDF file converters appear 
as installed printers on your computer.  

 
To create a PDF file of the detailed Test Report, choose the Print Test Report option in 
TECTITE Express, and then select the PDF file converter as the printer from the Print window 
(Bullzip PDF Printer in the example below).  When you send the print job, a file save 
window will appear where you can input the name and location of the file to be saved.  PDF 
files will be given an .pdf file extension.  The PDF file can be viewed using any PDF viewer 
(Adobe Reader is available for free from (www.adobe.com).  
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�  Creating and Viewing an XPS File:  All Windows Vista and Win 7 computers have both the 
Microsoft XPS Document Writer installed as a printer, and an XPS file viewer. Most 
Windows XP computers also have the XPS Document Writer installed, and XPS files can be 
viewed on XP computers using Internet Explorer. 

 
To create an XPS file of the detailed Test Report, choose the Print Test Report option in 
TECTITE Express, and then select Microsoft XPS Document Writer as the printer from the 
Print window.  When you send the print job, a file save window will appear where you can 
input the name and location of the file to be saved.  XPS files will be given an .xps file 
extension.  The XPS file can be viewed on all Vista and Win7 computers by simply double 
clicking on the file.  On XP computers, the XPS file can be viewed using Internet Explorer.  
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12.2  Putting Your Business Name and Logo on the Reports 
 
The name, address and contact information for your business can be placed at the top of the first page of all 
printed reports by completing the Business Info window.  To access the Business Info window, click on 
Options in the Main Menu, and then click on Business Info from the Options Menu.  Information entered 
in the Business Info window is saved as part of the data files. 
 

Business Information Window 

 
 
Adding Your Logo to the Top of Printed Reports:   
 
To insert a logo at the top of the printed reports, simply click on the Load New Logo button.  In the Select 
Logo File window which appears, find and select the desired image file from your computer.  TECTITE 
Express allows you to choose the following file types for a logo image: bmp, jpg, tif and emf.   
 
TECTITE Express makes a copy of the selected file and places the copy in the appropriate program 
directory on your computer.  The selected logo image is automatically placed in the upper left hand corner 
of the printed reports.  The image is placed in a 2.25 inch wide by 1.375 inch high box, and the program 
sizes the image (using its saved aspect ratio) to maximize its size within the box.  Logo images which have a 
2.25 to 1.375 width to height ratio will completely fill the image box.  Images with any other aspect ratio 
will only completely fill the image box in one dimension.  
 
To delete the stored logo image file, click on the Delete Logo button.  
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Chapter 13      Cruise Control   
 
 
The Cruise Control feature automatically adjusts the speed of the Blower Door fan to maintain a constant 
building pressure while the operator or technician performs additional diagnostic or air-sealing procedures.   
While cruising, the program displays the current building pressure and fan flow, and displays current zone 
pressures if the zonal pressures feature is active.  However, TECTITE Express does not store fan flow, 
building pressure or zone pressure data while cruising.  Common applications of the Cruise Control feature 
include: 
 

�  Pressure pan testing for evaluating leakage in forced air duct systems. 
�  Maintaining a constant building pressure while locating and sealing air leaks. 
�  Quickly estimating the building leakage rate before conducting a full airtightness test. 
�  Series leakage tests such as the Leakage Area Matching Method, or Add-a-Hole method to 

quantify leakage rates between various zones within a building. 
 
Note:  The Cruise Control feature can only be used if your Blower Door fan speed control has a 
communication jack on the side of the controller, and you have installed the fan control cable between the 
controller and your DG-700/DAB. 
 
 
13.1  Starting the Cruise Control Feature 
 
Before using the Cruise Control feature, be sure that the building and fan pressure tubing is properly 
connected to the DG-700/DAB.  
 

DG-700 Tubing Connections 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APT DAB Tubing Connections 
 
 

 
 
 
 
 
 
 
 

To outside 
(green tubing) 

To inside of building 
(leave open if DAB is 
in the building) 

 

To  BD fan 
(red tubing) 

To space upstream of fan inlet. 
(If fan inlet and DAB are in the 
same space, leave open) 
 

INPUT 

REF 

P1 P2 

To inside of building 
(leave open if gauge is 
in the building) 

 

To outside (green 
tubing) 

To space upstream of fan inlet. 
(If fan inlet and gauge are in the 
same space, leave open) 

To  BD fan 
(red tubing) 

A B 
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Cruise Control is activated from the Test Graph screen and can only begin if a communication link has been 
established between your computer and the DG-700/DAB.  If a communication link has been established, 
the message Idle -  Monitoring  appears in the green DAB Status Window and the Start and Cruise buttons 
are available.  For more information on establishing a communication link between your computer and the 
DG-700/DAB, see Chapter 15. 
 
To activate the Cruise Control feature, click on the Cruise button from the Test Graph screen.  Now fill in 
the Cruise Pressure field and select a Baseline option in the Cruise Test Conditions window which appears 
on screen. 
 

Cruise Test Conditions Window 
 

 
 
Cruise Pressure:   
 
Enter the building pressure (in Pa) that you would like the Blower Door fan to maintain.  Always enter the 
cruise pressure as a positive number, even if you are depressurizing the building.  For example, if the test 
mode is set to depressurize, and you wish to cruise at a building pressure of -50 Pa, enter the cruise pressure 
as 50.  The TECTITE Express program will now adjust the speed of the Blower Door fan until the cruise 
pressure is achieved, and will continuously adjust the fan speed to maintain the cruise pressure. 
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Baseline: 
 

�  No Baseline:    This option is used when you want to cruise without first measuring and 
adjusting for the baseline building pressure.  In other words, you will not adjust the displayed 
building pressure by the measured baseline pressure.  If you are displaying zone pressures 
while cruising, they will not be adjusted for the baseline zone pressure. 

 
�  Cruise With Baseline:   This option is used when you want to adjust the displayed building 

pressure by the measured baseline building pressure.  Use this feature when you want to 
change the building pressure by the specified cruise pressure.  For most users, this is the 
preferred cruising method.  If you are displaying  zone pressures while cruising, they will be 
adjusted for the measured baseline zone pressures. 

 
After clicking on OK in the Cruise Test Conditions window,  you will be asked to indicate which flow ring 
will be installed on the fan during cruising.  Click on the appropriate ring and then click on Proceed with 
Cruise.  This allows the program to display the fan airflow, as well as the  building and zone pressures 
while cruising.  Current fan airflow and building pressure are displayed in the Status Windows on the right 
side of the Test Graph screen, and by the moving cursor on the graph.4   The entered cruise pressure is 
displayed on the graph by a red vertical line.   
 
 
13.2  Ending Cruise/Stopping the Fan 
 
Once Cruise Control has been activated, there are two ways to turn off the cruise feature:  
 

�  Click on Pause or press the Esc key.  This immediately stops the fan, and the operator is 
allowed to either adjust the Auto Test Settings, re-start cruising or terminate the cruise 
procedure. 

�  Click on Stop Cruise.  This immediately stops the fan and ends the cruise procedure. 
 
 
13.3  Real-Time ACH50 Estimator 
 
When the Cruise Control feature is active, TECTITE Express will display a real-time estimate of Air 
Changes per Hour at 50 Pascals of building pressure (ACH50) on the Test Graph screen.  To estimate 
ACH50, TECTITE Express uses the current measured fan flow, the volume estimate input into the Building 
Test Info screen, and an assumed Building Leakage Curve exponent (n value) of 0.65.  The ACH50 display 
window is only active when the current building pressure is between 40 and 60 Pascals, and a valid fan flow 
measurement is being made.  The on-screen ACH50 display is useful for quickly estimating building 
leakage rates before conducting a full airtightness test.  

                                                 
4   If you activate the Cruise option while Blower Door data are being displayed on the graph, the data will remain on 
the graph and will not be affected or changed in any way.  
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Real-Time ACH50 Estimator 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  The Real-Time ACH50 display is also active when TECTITE Express is in the Idle – Monitoring  
mode and the user is manually adjusting the fan speed (and the current building pressure is between 40 and 
60 Pa). The Real-Time ACH50 display is not active during an automated test sequence. 
 
 
13.4  Using the Display Large Meters Feature 
 
The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) screen with 3 large 
status windows including Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The 
feature can be toggled on and off by clicking on Display Large Meters from the Options Menu. 
 
 
 
 
 
 
 
 
The Display Large Meters feature is particularly useful when looking at the computer screen from a distance 
while cruising or manually adjusting the Blower Door fan in Idle-Monitoring mode.  The Real-Time 
ACH50 display window is only active when the current building pressure is between 40 and 60 Pascals, and 
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an 
automated test sequence. 

  Ring  A

ACH50 Estimator Window 



 
Chapter 13    Cruise Control 

TECTITE Express  
Version 4.0 

55 

 
Large Meter Display 

 
 
 
 
 

  Ring  A
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Chapter 14      Creating and Using Configuration Files   
 
 
14.1  What is a Configuration File? 
 
There is a significant amount of data entry required in filling out all of the screens of TECTITE Express.  A 
configuration file is a place to save test settings, building and customer information, and comments that you 
routinely use so they can be quickly loaded into the program.  The configuration file can then be used as a 
shortcut for speeding up data entry for future tests.  A configuration file looks just like a building test file, 
except that no test data (i.e. building pressure or fan airflow readings) are stored in configuration files.5 
 
 
14.2  How to Create a Configuration File 
 
Before creating a configuration file, first be sure to save any current test data loaded into TECTITE Express 
by using the Save Current Test File option from the File Menu.   
 
Now select the New Test option from the File Menu.  Proceed through the Building Test Information,  
Comments, and Test Settings screens, filling in only the information which will be always be the same for 
your testing.  If there are any “standard” comments which you would like to have on all tests, type them in 
on the Comments screen at this time.  On the Test Settings screen, choose the settings you wish to save.   
Finally, open the Business Info, Equipment Info, and Units Selection windows (found in the Options Menu) 
and complete the appropriate fields.  
 
When you have finished entering information and settings that you wish to save, select Save Configuration 
File from the File Menu. 
 

 
When saving a configuration file, you will need to enter a file name and file location in the file saving 
browser that appears on screen.  All configuration files are automatically given a .cfa extension.   
 
 
14.3  How to Use Configuration Files 
 
To use a configuration file when conducting a new test, click on New Test with Custom Configuration 
from the File Menu. 

 
After selecting the “Custom Configuration” option, a file browser will appear on screen.  Select a .cfa file  
from the list (or browse to the file location) and then click Open.  Once the configuration file has been 
opened, the file information is loaded into the TECTITE Express program and the Building Test Info screen 
appears.   

                                                 
5  Information entered using the Options Menu (e.g.  Business Info, Equipment Info, and Unit Selection screens) are 
also stored when a configuration file is created. 
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After loading the selected configuration file, complete the remaining data entry fields and proceed with the 
test.  Importantly, you are not “locked into” the entries which were loaded from your configuration file.  
You can always edit all data entry fields during the test. 
 
Some users may wish to create custom configuration files for a variety of testing situations they frequently 
encounter.  For example, a user may have separate configuration files for each city where they frequently 
test.  Configurations can also be created which are specific to: 
 
 test location 

test standard 
 house type 
 fan model and serial number 
 testing protocol (e.g. custom pressure lists) 
 calm versus windy conditions 
 
Keep in mind that the Comments screen can be a particularly useful part of custom configuration files by 
containing “boiler plate” comments which you would like to print out (or edit) for all tests. 
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Chapter 15     Troubleshooting TECTITE Express   
 
 
15.1  Basic Tips 
 
·  If there is an on-screen warning message, refer to the list of Operator Messages in Chapter 7. 
·  If you are having trouble completing an automated Blower Door test or Cruise procedure, first check 

that the Blower Door and DG-700/DAB system are set up as shown in Chapter 2.   
 
Refer to example problems below for information on more specific operating problems. 
 
Problem 1:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 
message:   “Primary Device IS NOT CONNECTED”.  

 
The Primary Device is the DG-700 or APT DAB that will be used to measure building pressure and fan 
flow during the Blower Door test.  When the Method field (in the Test Settings screen) is set to Auto or 
Semi-Auto, and you are viewing the Test Graph, TECTITE Express will attempt to establish a 
communication link with a Primary Device through the Primary COM Port  specified in the COM Port 
Selection window.  Failure to establish a communication link will result in the Primary Device IS NOT 
CONNECTED message appearing. 

 
There are two options for specifying a Primary COM Port  in the COM Port Selection window: 
 
�  Checking the AUTO SELECT button will allow TECTITE Express to automatically search for TEC 

devices on all available communication port on your computer.  If you are unsure which COM Port to 
use, check the AUTO SELECT button. AUTO SELECT will attempt to establish a communication 
link with the first Energy Conservatory Device that it finds.  If a communication link is established, this 
device is considered the Primary Device. 

 
�  If you uncheck AUTO SELECT, you may specify a Primary COM Port  (COM 1 thru COM 256).   

 
Scanning for Port and Devices: 
 
The easiest way to quickly check your computer for all currently installed communication ports and 
connected Energy Conservatory Devices is to use the Scan for Ports and Devices button in the COM Port 
Selection window.  Once the Scan window is open, clicking on Start Scan will provide a list of all installed 
communication ports on your computer.  The scan will also show all Energy Conservatory Devices that are 
connected to the listed communication ports.  Note:  The Energy Conservatory Device must be ON to be 
detected. 
 
Other items to check if you are having communication problems:   
 
�  Make sure that you have properly installed the communication cable between your computer and the 

Energy Conservatory Device. 
�  Check that the Energy Conservatory Device has been turned ON and has power. 
�  Make sure you are not running 2 copies of TECTITE Express at the same time. 
�  Make sure that other devices are not attempting to use the designated COM port on your computer. 
 
Once the proper communication link has been established, the message Idle Monitoring  appears in a green 
DAB Status Window at the bottom of the Test Graph screen.  



 
Chapter 15    Troubleshooting TECTITE Express 

TECTITE Express  
Version 4.0 

59 

 
Problem 2:  During an automated  test, the program never starts taking data at a target pressure line,   
       even though the Airflow and Building Pressure Cursor appears to be bouncing around the 
        target pressure.  After a few minutes the message  “Warning excessive building pressure  

     fluctuation for the current target pressure..” appears. 
 
In order for the TECTITE Express program to start taking data at any target pressure line, it must first 
determine that the current measured building pressure is within a specified range from the target building 
pressure. This specified range is called the Target Tolerance.  If the current measured building pressure is 
fluctuating beyond the Target Tolerance, then data collection for that target pressure will not begin.  
Fluctuating building pressure readings can be caused by improper installation of the building pressure 
reference tubing, or by windy weather. 
 

�  First check to be sure that the outside end of the building pressure tubing (e.g.  the green tubing 
connected to the Channel A/P1 Reference tap) is not placed directly in the exhaust airflow of the 
Blower Door fan.  You must be careful to run the end of the tubing well away (at least 5 feet to the 
side) from the exhaust of the fan.  A good location for the end of the building pressure tubing is at the 
base of the building where it meets the ground.   

 
Note:  Although it is common practice for Blower Door operators to insert the open end of the 
building pressure tubing a few inches through the patch on the nylon panel, and leave it, we have 
determined that this set up practice can create inaccurate building pressure readings due to the 
exhaust airflow from the fan hitting the end of the tubing.  You should always follow the tubing 
set-up practice listed above to prevent fluctuating building pressures.   

 

�  If the building pressure tubing is installed correctly, the fluctuating building pressures are probably 
caused by wind.  Try increasing your Target Tolerance to 3 or 4 from the default value of 2 (the Target 
Tolerance can be changed by clicking on the Adjust Auto Test Settings button in the warning screen).  
If this doesn’t work, increase the Target Tolerance to 5 or greater, or use the Sample button (see 
below).   

 
�  During an automated test, you can manually instruct the computer to go ahead and take data by clicking 

on the Sample button.  At this point, the computer will proceed just as if it has decided that the Target 
Tolerance for the current pressure station line had been met. 

 
Note:  As the Target Tolerance is increased from the default value of 2, gathered data may not be 
as close to the target pressure lines as would be the case when using the default value.  This has 
negligible effect on the final test results.  However, some test standards do require that the 
measured building pressures be within a specified range of the target pressure (e.g. the CGSB test 
standard requires that the measured building pressures be within +/- 2.5 Pa of the specified target 
pressure). 

 
 
Problem 3:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 
message:  “Aux X Device IS NOT CONNECTED”.  

 
Aux Device(s) are additional DG-700s or APT DABs that can be used exclusively to measure zonal 
pressures during the Blower Door test using the Zonal Pressures feature.  If a communication link has been 
established with the Primary Device, and the Zonal Pressures feature has been turned on (Test Settings 
screen), TECTITE Express first checks to see if the Primary Device has sufficient pressure channels to 
measure the active zone pressure channels.  For example, if your Primary Device is an APT DAB with 6 
installed pressure channels, you would be able to measure up to 4 zone pressures without needing an Aux 
Device (the first two channels on the Primary Device are always used to measure building pressure and 
Blower Door fan flow).  On the other hand, if your Primary Device is a DG-700 gauge, then you will need 
to use two Aux DG-700’s to measure 4 zone pressures.   
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If the Primary Device does not have sufficient channels, then TECTITE Express tries to establish a 
communication link with an Energy Conservatory Device using the specified Aux 1 COM Port.  If a 
communication link can not be established through the Aux 1 COM Port, then the message “Aux 1 Device 
IS NOT CONNECTED” appears.  If a communication link is established through the Aux 1 COM Port but 
there are still insufficient pressure channels available for the active zone pressures measurements, then 
TECTITE Express repeats the same process for the designated Aux 2 and Aux 3 COM Ports.  Note:  
When specifying Aux COM Ports, always use the Aux COM Ports in order from Aux 1 to Aux 3. 
 
AUTO SELECT must be unchecked in order to specify Aux COM Ports.  If you will not be using the 
Zonal Pressures feature, leave all three Aux COM Ports set to None and uncheck the Active button in the 
Zonal Pressure feature field in the Test Setting screen. 
 
 
Problem 4:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 
message:   “Insufficient channels for test.”  

 
The “Insufficient channels for test” message appears under the following circumstances: 
 
A communication link has been established with the Primary Device and any designated Aux Devices, and  
 
�  The Zonal Pressures feature has been activated (Test Setting screen), and 
�  There are insufficient pressure channels available for the active zone pressure measurements.  
 
You will either need to specify additional Aux COM Ports and Devices, or reduce the number of active 
zone pressure measurement channels, or turn off the Zonal Pressures feature. 
 
 
Problem 5:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 
message:   “OFF LINE:  Communication with devices disabled.”.  

 
The OFF LINE feature is used to prevent TECTITE Express from communicating with Primary  or Aux 
Devices when viewing the Test Graph screen.  This feature increases the responsiveness of TECTITE 
Express when viewing previously stored data files.  In order to conduct automated Blower Door tests, you 
will need to uncheck the OFF LINE feature box in the COM Port Selection window.   
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Chapter 16     Evaluating the Repeatability of Test Results   
 
 
You may have wondered how much the test results of a building would change if you immediately repeated 
the test and compared the two results.  The maximum change likely from one test to another is called 
“repeatability”.   The TECTITE Express program calculates an estimate of test repeatability and displays 
this estimate along with the test results.  Note: This estimate assumes the building was unchanged from one 
test to another and the weather conditions were similar. 
 
One of the strengths of automated Blower Door testing is its ability to automate the data collection process 
and make repeatable airtightness measurements in both calm and windy weather conditions.  During 
automated testing, TECTITE Express is able to quickly gather and analyze hundreds of times more readings 
during a single test sequence than would be practical with a manual Blower Door test.  By quickly 
collecting large samples of data, the repeatability of test results is greatly improved over manual test 
methods without laborious data entry or hand calculations.  In addition, if very good repeatability is needed, 
multiple tests on the same building can be quickly performed and combined on the Test Graph to further 
increase the test precision. 
 
 
16.1  Looking at the Repeatability of Test Results 
 
The repeatability of the test results can be quickly evaluated by looking at the calculated standard errors that 
are shown on the Test Results Screen (i.e.  the “ +/-    % value shown to right of Airflow at 50 Pascals, 
Leakage Areas and Building Leakage Curve results - see Figure below).6    Once a test has been 
completed, look at the Test Results Screen to determine if the repeatability of the test results is sufficient to 
meet your needs. 

 
Calculated Standard Errors of Test Results 

 
 
Note:  Standard error calculations are reported when using both Auto and Manual Test Methods. 
 
The standard errors, shown as a percentage of the measurement, give you an estimate of how much the 
measurement could change if you repeated the test.  For example, from Figure above, a 0.3% standard error 
in the CFM50 reading of 3,673 means that if you repeated the test, the new CFM50 reading would 

                                                 
6  These standard errors are statistical estimates of repeatability calculated according to CGSB Standard 149-10 M86.  
One assumption made is that data points deviate from a straight line due to random variations in pressure and flow  
measured during a test. 

Standard  
Errors 
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not likely differ by more than 11.0 CFM50 (3,673 x 0.003).  In this case the repeatability of our CFM50 
reading is quite good since separate repeated tests of this building would likely produce readings of between 
3,662 and 3,684 CFM50. 
 
If you are conducting an airtightness test to simply measure the current airtightness level of a building, or to 
estimate the natural infiltration rate of a building, we suggest that standard errors of test results on the order 
of +/- 5.0% are generally acceptable.  The results in the Figure above are all well within our recommended 
5.0% guideline.   
 
If on the other hand, you are comparing two or more Blower Door tests to determine a change in 
airtightness (e.g. to document the performance of airsealing work, or as part of a series leakage diagnostic 
procedure), then better repeatability may be warranted.  When comparing two Blower Door tests, we often 
recommend that the standard error in both tests be less that 20% of the measured change in airtightness.   
 
For example, suppose we conducted two separate tests on a building, one before airsealing was performed, 
and one after airsealing was performed, and the results of the tests were as follows: 
 
�  Pre Airsealing CFM50 =    2,565  (+/-   3.2%)   standard error = 2565 x 0.032 =  82.1 
 
�  Post Airsealing CFM50 =   2460  (+/-    2.9%)  standard error = 2460 x 0.029 =  71.3  
 
The calculated change in airtightness =  105 CFM50  (2565 minus 2460).   20% of the change in 
airtightness = 21.0 (105 x 0.2). 
  
In this case, both test standard errors of  82.1 and 71.3 are greater than 20% of the measured change (or 
21.0 CFM50), therefore we should not accept the measured change of 105 CFM50 as a valid result.  We 
would need to increase the repeatability of our tests (i.e. reduce the standard error) in order to accurately 
measure this relatively small change in building airtightness. 
  
 
16.2  Improving the Repeatability of Automated Test Results 
 
The simplest way to improve the repeatability of automated test results is to conduct one or more additional 
tests (using the same Test Mode) and have the TECTITE Express program combine all data into one test 
result.  Data from more than one test can always be combined on the graph.  This occurs when starting a 
new test sequence while data from a previous test are currently on the graph screen.  For example, if you 
perform a test and after reviewing the Test Results screen you would like to increase the repeatability (i.e. 
reduce the standard error) of the test results, begin another test (by clicking on the Start Test button), and 
do not clear the previous data prior to starting the second test. 
 
When viewing the Test Results screen with data from multiple tests (using the same Test Mode) on the 
graph, results are calculated using all data points displayed on the screen.7   In addition, the Completed Test 
Indicator on the Test Graph Screen will be updated to reflect the number of completed tests being 
displayed. 
 
Note:  When combining multiple tests, the calculated standard errors in the results will generally decrease 
as more tests are added.  However, the calculated correlation coefficient will typically remain about the 
same and may even get worse.  Therefore, when evaluating the repeatability or precision of a test, the most 
important factor to consider is the standard errors in the test results. 
 

                                                 
7   When there are multiple test results on-screen, TECTITE Express adjusts the collected data for each individual test 
by the baseline building pressure readings taken immediately before and after that test. 
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16.3  Improving the Repeatability of Manual Test Results 
 
Improving repeatability when conducting Manual Tests is not as easy.   However, there are a few simple 
strategies for increasing Manual Test repeatability. 
 

�  Collect more data points during each test.  The manual entry Data Table will accept up to 12 
sets of Blower Door test readings.  Collecting 12 sets of Blower Door data will almost always 
increase repeatability over collecting 5 sets of data.   

�  Use a longer time average setting for each baseline and fan-on period. 
�  Conduct separate tests and manually average the calculated results.   
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Chapter 17      Entering Custom Fan Calibration Parameters  
 
 
The TECTITE Express program comes installed with factory default fan calibration parameters for the 
Model 3 and Model 4 Minneapolis Blower Door and Series A and B Duct Blaster fans.  The fan calibration 
parameters are used by the program to convert the measured fan pressure in Pascals to airflow in the units 
selected in the Units Selection window (see Chapter 18).   
 
If your Blower Door fan was custom calibrated by The Energy Conservatory, you can input your custom 
calibration parameters directly into the TECTITE Express program in lieu of the factory default values.  To 
enter custom fan calibration parameters, first be sure that the airflow units chosen in the Units Selection 
window (found under the Options menu) match the airflow units corresponding to the custom calibration 
parameters.  Now open the Equipment Info window by clicking on Options....Equipment Info from the 
Main TECTITE Express Menu. 

 
 

Equipment Information Window (Auto and Semi-Auto Methods) 

 
From the Equipment Info window, be sure you have selected the appropriate fan model from the pull down 
menu, and then input the fan serial number.  Now click on the Enter Custom Fan Calibration button to 
open the Fan Calibration Parameter window. 
 

Note:  If you are conducting an Automated or Semi-Automated test, the TECTITE Express 
software will automatically store the micromonometer serial number and calibration information as 
part of the building test file.  If you are conducting a Manual test, the Equipment Info window will 
include fields where you can input and store a micromonometer serial number and calibration date 
(see Equipment Information Window (Manual Method  below).   

 
Note 2:  If you If you change the selected fan model while test data are being displayed on the 
graph, the test data will automatically be cleared. 
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Fan Calibration Parameters Window 

 
The Fan Calibration Parameter window shows the calibration parameters being used by the program for the 
currently selected fan model and selected airflow units.  There is a unique set of parameters for each of the 
flow ring configurations used with the fan.  The individual calibration parameters can be edited by using the 
Tab key, or by clicking on the input fields.  Whenever you input a custom calibration parameter, the new 
value shown in the field will be displayed in red, rather than black for the default values.  You can easily 
return all calibration parameters to the factory default values by clicking on Set to Defaults.  The currently 
entered fan calibration parameters are stored as part of the data file. 
 
Note:  Most users should never have to edit fan calibration parameters.  The default fan calibration 
parameters which come with TECTITE Express are valid for all standard Minneapolis Blower Door and 
Duct Blaster fans.  This feature is necessary only if you receive custom calibration parameters for your fan 
from The Energy Conservatory. 

 
 

Equipment Information Window (Manual Method) 
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Chapter 18      Selecting Units   
 
 
18.1  Using the Units Selection Window 
 
TECTITE Express allows you to select the units used to represent a number of variables in the program 
including airflow, temperature, building dimensions and leakage areas.  The selected units are used in the 
program screens, the printed reports and in the saved building test files.   
 
To choose units, open the Units Selection window by clicking on  Options...Units Selection  from the Main 
TECTITE Express Menu. 

 
Units Selection Window 

 
In the Units Selection window, click on the desired units in each of the four selection fields, then click on 
OK to accept your choices.  Once OK is pressed, any changes made to selected units take place 
immediately in the Input, Test Settings, Test Graph and Results screens.  If you would like the selected units 
to automatically be used each time TECTITE Express is run, click on the Set as Defaults button.   
 
Note:  If you change the selected units while test data are currently being displayed on any of the program 
screens, the data will be immediately converted to the new units.  Because some slight rounding errors may 
occur during the conversion to new units, it is best to change units before entering any data into the 
program. 
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18.2  Units Used When Retrieving Saved Test Files 
 
When a previously saved building test file is retrieved (using  File....Retrieve Existing Test), TECTITE 
Express displays the test data in the units that were chosen at the time the test was saved.  The Units 
Selection window is also reset to the settings chosen when the test was saved.  Once the file has been 
retrieved, the units can be changed by simply editing the Units Selection window (see Note above).   
 


